LEGACY SNAP ETHERNET-BASED I/O UNITS USER’S GUIDE

SNAP Simple I/O™
SNAP Ethernet I/O™
SNAP Ultimate I/O™

Form 1460-231226—December 2023

OPTO 22
Your Edge in Automation™

43044 Business Park Drive • Temecula • CA 92590-3614
Phone: 800-321-OPTO (6786) or 951-695-3000
Fax: 800-832-OPTO (6786) or 951-695-2712
www.opto22.com

Product Support Services
800-TEK-OPTO (835-6786) or 951-695-3080
Fax: 951-695-3017
Email: support@opto22.com
Web: support.opto22.com
# Table of Contents

## Chapter Introduction 1

Welcome to SNAP Ethernet-Based I/O ................................................................. 1
  Hardware ........................................................................................................ 1
  Software .......................................................................................................... 2
About this Guide .................................................................................................. 3
  Information Key ................................................................................................ 4
  Other Documents You May Need ..................................................................... 4
For Help ............................................................................................................. 5

## Chapter Installing a SNAP Ethernet-Based I/O Unit ................................. 7

What You Will Need ........................................................................................... 7
Installing Software ............................................................................................. 7
Installing Hardware ........................................................................................... 8
  Installing Modules on the Rack ....................................................................... 8
  Removing a Module ......................................................................................... 9
  Installing the Brain or Controller ................................................................ 10
What’s Next? ..................................................................................................... 11
Configuring I/O ................................................................................................. 11
Using PPP Over a Modem .................................................................................. 12
  Configuring PPP on the I/O Unit .................................................................... 13
  Attaching the Modem to the SNAP Ethernet-Based I/O Unit ................. 16
  Configuring Microsoft Windows Dial-up Networking on Windows 2000 .... 17

## Chapter System Architecture ........................................................................ 21

Communication Options .................................................................................... 21
  Simultaneous Communication ...................................................................... 22
  Accessing SNAP Ethernet Systems I/O Units Over the Internet ............ 23
  Choosing Communication Methods ................................................................. 23
System Architecture—SNAP Simple I/O .......................................................... 24
System Architecture—SNAP Ethernet I/O .......................................................... 26
System Architecture—SNAP Ultimate I/O ......................................................... 26
  Understanding the SNAP Ultimate Brain ....................................................... 27
  The I/O Side of the Brain ................................................................................. 27
  The Control Side of the Brain ......................................................................... 27
  Controlling the System .................................................................................... 28
# Chapter Maintaining the Ethernet-Based I/O Unit

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>43</td>
</tr>
<tr>
<td>Backup Battery</td>
<td>43</td>
</tr>
<tr>
<td>Changing or Viewing the IP Address</td>
<td>43</td>
</tr>
<tr>
<td>Changing the IP Address</td>
<td>44</td>
</tr>
<tr>
<td>Brains with Firmware Version 5.0 or Newer</td>
<td>44</td>
</tr>
<tr>
<td>Brains with Older Firmware</td>
<td>45</td>
</tr>
<tr>
<td>Viewing the IP Address</td>
<td>47</td>
</tr>
<tr>
<td>Resetting a Brain to Factory Defaults</td>
<td>50</td>
</tr>
<tr>
<td>Loading New Firmware</td>
<td>51</td>
</tr>
<tr>
<td>Loading SNAP Ultimate Brain Firmware</td>
<td>52</td>
</tr>
<tr>
<td>Loading Brain Firmware (All Other Brains)</td>
<td>54</td>
</tr>
</tbody>
</table>

# Chapter Troubleshooting

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communicating with the I/O Unit</td>
<td>59</td>
</tr>
<tr>
<td>Pinging the I/O Unit</td>
<td>60</td>
</tr>
<tr>
<td>Accessing the I/O Unit with ioManager</td>
<td>60</td>
</tr>
<tr>
<td>Solving Network Problems</td>
<td>62</td>
</tr>
</tbody>
</table>
Welcome to SNAP Ethernet-Based I/O

IMPORTANT: The SNAP Ultimate, SNAP Ethernet, and SNAP Simple I/O units covered in this guide are no longer recommended for new development. Because they have reached their hardware limits, we have had to replace them with new SNAP PAC products.

SNAP PAC controllers and I/O processors are more powerful, include additional functionality, and are generally less expensive than the older units. Please see our website, www.opto22.com, or call us at 800-321-6786 or 951-695-3000 for information about SNAP PAC controllers and brains.

Opto 22’s legacy SNAP Ethernet-based I/O units offer you a versatile input/output (I/O) system for local and remote monitoring, industrial control, and data acquisition. Based on the Internet Protocol (IP), these systems offer flexibility in both the physical network on which they sit and in the software applications with which they interface.

- Ethernet-based I/O units can be placed on an Ethernet network or be used with a modem over PPP (point-to-point protocol).
- Ethernet-based I/O units can send data to and receive data from a wide variety of software applications, including human-machine interfaces (HMIs); manufacturing resource planning (MRP), enterprise management, and other enterprise systems; databases; email systems; OPC client software; Modbus/TCP software and hardware; and custom applications; as well as Opto 22’s own control and HMI software.

Hardware

Each SNAP Ethernet-based I/O unit consists of a processor (called either a brain or an on-the-rack controller), a mounting rack, and Opto 22 SNAP analog, digital, and special-purpose input/output modules that connect to the equipment and devices you need to monitor, control, or acquire data from. I/O units come in three categories.
SNAP Simple I/O™ is the low-cost, high-quality solution for simple monitoring, control, and data acquisition using a wired Ethernet network. SNAP Simple I/O is designed for high-density commercial and industrial applications. It offers simple digital and serial capabilities, plus full analog features, all on the same rack. For a control system, use SNAP Simple I/O with an Opto 22 SNAP PAC programmable automation controller.

SNAP Ethernet I/O™ offers analog, digital, and serial features, including high-speed counting (20 kHz), quadrature counters, events and reactions, PID loops, thermocouple linearization, output clamping, and much more. Racks hold 4, 8, 12, or 16 modules. For control, use SNAP Ethernet I/O units with one of Opto 22’s SNAP PAC programmable automation controllers. All models can use a wired network or modem over point-to-point protocol (PPP).

SNAP Ultimate I/O adds the ability to run flowchart-based control strategies on the I/O unit. You develop these strategies with ioControl™ software, which is included with the purchase of a SNAP Ultimate on-the-rack controller. SNAP Ultimate I/O can also control other Ethernet-based I/O units for an extended system. All models run on a wired network or a modem over PPP.

NOTE: For new development, Opto 22 recommends a SNAP PAC R-series on-the-rack controller instead of SNAP Ultimate I/O.

For a detailed comparison of models and features, see specifications and comparison charts starting on page 35.

Software

All Ethernet-based I/O units are programmed with Opto 22’s ioProject™ software. The last release of ioProject software was version 7.1.

NOTE: The newer PAC Project 8.0 software supports these I/O units when used with a SNAP PAC controller, but support will be phased out over time.

ioProject Basic is included with your purchase of SNAP Ultimate I/O. Version 7.1 is also still available for download from our website, www.opto22.com. ioProject Basic includes:

- ioControl™, a graphical, flowchart-based programming tool for developing software applications to monitor, control, and acquire data from equipment, processes, and devices. In addition to flowchart programming, ioControl includes a powerful, built-in scripting language based on C and other procedural languages.
• **ioDisplay™**, an intuitive package for building operator interfaces (HMIs) for your Microsoft® Windows®-based clients communicating with a SNAP Ultimate I/O system. ioDisplay offers a full-featured HMI including alarming, trending, security, and a built-in library of 3,000 industrial automation graphics.

• **ioManager™**, a utility application used to assign IP addresses, configure I/O points and I/O unit features, and inspect, read, and write to I/O units on a one-time basis. For multiple I/O units that use the same configuration, you can configure all I/O units simultaneously.

For communication with OPC clients, purchase **OptoOPCServer™**, an OLE for Process Control (OPC) 2.0-compliant server. OptoOPCServer can be purchased separately or as part of the PAC Project Professional software suite. For more information on PAC Project, see the PAC Project Data Sheet (form #1699) on our website, www.opto22.com. In addition, SNAP Ethernet-based I/O units are compatible with the following:

• If you are already using **Modbus®/TCP**, you do not need additional software. The Modbus/TCP memory map and instructions for use are in form #1678, the **Modbus/TCP Protocol Guide**, which is included on the CD that came with the brain or controller.

• If you need to write your own **custom applications** in Visual Basic® or C++, our OptoMMP™ Communication Toolkit (previously called the SNAP Ethernet I/O Driver Toolkit) with ActiveX components and C++ classes is included on the CD that came with the brain or controller. For instructions, see Opto 22 form #1465, the **OptoMMP Protocol Guide**, also included on the CD.

• If you are programming for **Linux®** or another operating system other than Microsoft® Windows®, the OptoMMP memory-mapped protocol for communicating with Ethernet-based I/O units is open and documented in Opto 22 form #1465, the **OptoMMP Protocol Guide**, included on the CD that came with the brain.

---

**About this Guide**

This guide shows you how to install and use the legacy SNAP Ethernet-based I/O units. This guide assumes that you have some familiarity with TCP/IP and Ethernet networking. If you are not familiar with these subjects, we strongly suggest you consult commercially available resources to learn about them before attempting to install or use SNAP Ethernet-based I/O units.

The following sections are included in this user’s guide:

**Chapter 1, “Introduction”**—information about the guide and how to reach Opto 22 Product Support.

**Chapter 2, “Installing a SNAP Ethernet-Based I/O Unit”**—quick-start steps to get SNAP Ethernet-based I/O units up and running quickly.

**Chapter 3, “System Architecture”**—conceptual information on networking and communicating with SNAP Ethernet-based I/O units; comparisons of SNAP Ultimate, SNAP Ethernet, and SNAP Simple I/O features and capabilities; specifications for SNAP Ethernet-based brains.

**Chapter 4, “Maintaining the Ethernet-Based I/O Unit”**—assigning and changing IP addresses, resetting the I/O unit to factory defaults, and upgrading firmware.

**Chapter 5, “Troubleshooting”**—tips for resolving difficulties you may encounter while working with SNAP Ethernet-based I/O units.
Appendix A, “SNAP I/O Wiring Diagrams”—diagrams for wiring SNAP I/O analog, digital, and serial modules to the devices they monitor and control, along with information on racks and power supplies.

Information Key

This guide includes information that applies to some types of Ethernet-based I/O units but not to others. Sections are marked as follows to indicate the products that support them:

<table>
<thead>
<tr>
<th>This text</th>
<th>Indicates support by this hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>UIO</td>
<td>SNAP Ultimate I/O</td>
</tr>
<tr>
<td>EIO</td>
<td>SNAP Ethernet I/O</td>
</tr>
<tr>
<td>SIO</td>
<td>SNAP Simple I/O</td>
</tr>
</tbody>
</table>

Other Documents You May Need

See the following additional guides for the information listed. All guides are available on the Opto 22 website, www.opto22.com; some are included on the CD that came with the SNAP Ethernet-based brain or controller.

<table>
<thead>
<tr>
<th>For this information</th>
<th>See this guide</th>
<th>Form #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring I/O points and system functions</td>
<td>ioManager User’s Guide</td>
<td>1440</td>
</tr>
<tr>
<td>Designing flowchart-based control programs for the system (requires a SNAP PAC S-series or R-series, SNAP Ultimate I/O, or a SNAP-LCE industrial controller)</td>
<td>ioControl User’s Guide</td>
<td>1300</td>
</tr>
<tr>
<td></td>
<td>ioControl Command Reference</td>
<td>1301</td>
</tr>
<tr>
<td></td>
<td>ioControl Commands Quick Reference Card</td>
<td>1314</td>
</tr>
<tr>
<td>Communicating with I/O units using OPC</td>
<td>OptoOPCServer User’s Guide</td>
<td>1439</td>
</tr>
<tr>
<td>Communicating with I/O units using Modbus/TCP</td>
<td>Modbus/TCP Protocol Guide</td>
<td>1678</td>
</tr>
<tr>
<td>Programming your own applications for SNAP Ethernet-based I/O units using the OptoMMP Communication Toolkit (previously called the SNAP Ethernet I/O Driver Toolkit) or the OptoMMP memory-mapped protocol</td>
<td>OptoMMP Protocol Guide</td>
<td>1465</td>
</tr>
</tbody>
</table>
For Help

If you have problems installing or using SNAP Ethernet-based I/O units and cannot find the help you need in this guide or on our website, contact Opto 22 Product Support.

Phone: 800-TEK-OPTO (800-835-6786 toll-free in the U.S. and Canada) 951-695-3080
Monday through Friday, 7 a.m. to 5 p.m. Pacific Time

Fax: 951-695-3017

Email: support@opto22.com

Opto 22 website: www.opto22.com

When calling for technical support, be prepared to provide the following information about your system to the Product Support engineer:

- Software and version being used
- Brain and controller firmware version (as applicable)
- PC configuration (type of processor, speed, memory, and operating system)
- A complete description of your hardware and operating systems, including:
  - jumper configuration
  - loader and kernel versions for the brain, and date codes of I/O units (available through ioManager; see page 66.)
  - IP addresses and net masks for devices on the system
  - accessories installed (such as expansion cards)
  - type of power supply
  - third-party devices installed (for example, barcode readers)
- Specific error messages seen.

NOTE: Email messages and phone calls to Opto 22 Product Support are grouped together and answered in the order received.
Installing a SNAP Ethernet-Based I/O Unit

If you already know how you will use the SNAP Ethernet-based I/O unit and want to get it running quickly, follow the sections in this chapter.

To learn about communication options and networking, start on page 21. Specifications are listed on page 35.

What You Will Need

You’ll need the following items to install a SNAP Ethernet-based I/O unit:

- PC running Microsoft® Windows® 2000 or higher, with a 10/100 MB Ethernet adapter card, the TCP/IP protocol installed, and a valid IP address, on the same subnet as the I/O unit. (For more information, see “Networking” on page 32.)
- Crossover cable (for direct connection to the PC), or an available connection to a standard 10BASE-T or 100BASE-TX Ethernet network.
- SNAP Simple, SNAP Ethernet, or SNAP Ultimate I/O processor (See page 37 for a chart comparing models.)
- SNAP mounting rack and SNAP I/O modules. Choose rack and modules based on your needs. Make sure the rack is compatible with your brain or controller model (see page 71).
- A SNAP-PS5 or SNAP-PS5U power supply or other 5 VDC power supply (-0/+0.1 VDC at 4.0 A) applied to the rack. Additional power may be required for SNAP I/O modules and depends on the number and type of modules used. For more information, see “Determining Power Requirements” on page 74.

Installing Software

In your CD-ROM drive, insert the CD that came with the brain or controller. The installation wizard should start automatically. If it doesn’t, use Windows Explorer to navigate to your CD-ROM drive and then double-click setup.exe. Follow directions to install the software.
Installing Hardware

Assemble the rack and power supply according to the directions that came with them. For help with wiring, see “SNAP I/O Wiring Diagrams” on page 71 or the product data sheets, which are available on our website at www.opto22.com.

Installing Modules on the Rack

Modules snap into place in the row of connectors on the rack. Each module connector has a number.

CAUTION: Make sure you are using the correct rack for your processor (see chart on page 72). Using the wrong rack will severely damage the processor.

1. Place the rack so that the module connector numbers are right-side up, with zero on the left. (If your rack has screw connectors, the screw connectors will be at the bottom.)

2. Position the module over the module connector, aligning the small slot at the base of the module with the retention bar on the rack.

3. With the module correctly aligned over the connector, push on the module to snap it into place.

When positioning modules next to each other, be sure to align the male and female module keys (shown in the detailed view in the illustration at right) before snapping a module into position.

Modules snap securely into place and require a special tool (provided) to remove them. To remove a module, see page 9.
4. (Optional) As shown in the photo at right, use standard 4-40 x 1/4 truss-head Phillips hold-down screws to secure both sides of each module.

   **CAUTION:** Do not over-tighten screws.

5. Plug the wiring connector into each module to attach modules to the devices they monitor.

   Wiring diagrams are in Appendix A, “SNAP I/O Wiring Diagrams,” and in the module’s data sheet.

---

**Removing a Module**

1. If the modules are held in place with screws, remove them.

2. Holding the SNAP module tool (provided) as shown in the illustration at right, insert it into the notch at the base of the module.

3. Squeeze the module tool against the module to open the release latch, and pull straight up on the module to remove it.

4. Continue with “Installing the Brain or Controller” on page 10.
Installing the Brain or Controller

CAUTION: Make sure you install the processor (brain or on-the-rack controller) on the correct rack (see page 72). Using the wrong rack will severely damage the processor.

1. Remove the brain from its packaging.
2. Turn off power to the rack assembly.
3. Align the brain connector with the mating connector on the mounting rack, as shown in the diagram at right.
4. Seat the brain onto the connector and use the hold-down screw to secure the brain in position. Do not overtighten.
5. Using Category 5 or superior solid unshielded twisted-pair cable, connect the brain in one of the following ways:
   - (Recommended for initial configuration) Connect to a PC directly, using an Ethernet crossover cable.
   - Connect to a standard 10BASE-T or 100BASE-TX Ethernet network that has a PC on the same subnet as the brain and does NOT have a Dynamic Host Configuration Protocol (DHCP) server.

Maximum cable or segment length is 100 meters; minimum cable length is one meter. For more information on cables, see page 32.

6. **For brains used with a modem:** Also see “Using PPP Over a Modem” on page 12.
7. **Before** turning on power to the rack, follow instructions in Opto 22 form #1440, the ioManager User’s Guide, to assign an IP address to the I/O unit.

This guide is in Adobe Acrobat PDF format on the CD that came with the brain or controller and is also available from our website, www.opto22.com.
What’s Next?

To start configuring I/O units and I/O points, see “Configuring I/O,” below.
To learn more about SNAP Ethernet-based I/O unit capabilities and network options, see Chapter 3, “System Architecture.”
To use OLE for process control (OPC) with SNAP Ethernet-based I/O units, purchase the OptoOPCServer and see Opto 22 form #1439, the OptoOPCServer User’s Guide.
To communicate with I/O units using Modbus/TCP, see form #1678, the Modbus/TCP Protocol Guide.
To program your own applications, see Opto 22 form #1465, the OptoMMP Protocol Guide.

Configuring I/O

No matter how you communicate with SNAP Ethernet-based I/O units, you will need to configure I/O points and I/O unit features.

If you are not using ioControl (Opto 22’s flowchart-based control software), follow instructions in the ioManager User’s Guide (Opto 22 form #1440).

If you are using ioControl, I/O units and points must be configured to match the ioControl strategy you will run. You can configure most Ethernet-based I/O unit and point functions either in ioControl or in ioManager.

If you are already in ioControl, configuration is easier there and you can use the loopback IP address for SNAP Ultimate I/O units controlling themselves. However, some functions for Ethernet-based I/O units cannot be configured in ioControl.

If you use ioManager, you can save your configuration to a file, load it to multiple I/O units at once, and use it for referencing points in OPC. However, you cannot use the loopback address in ioManager.

Choose your configuration tool based on what you need to do:

<table>
<thead>
<tr>
<th>Use ioControl for I/O configuration if</th>
<th>Use ioManager for I/O configuration if</th>
</tr>
</thead>
<tbody>
<tr>
<td>• You have only one I/O unit or I/O unit configurations are different.</td>
<td>• You have multiple I/O units whose configurations are exactly the same or similar.</td>
</tr>
<tr>
<td>• The strategy will run on SNAP Ultimate I/O units that are controlling themselves using the loopback IP address, 127.0.0.1</td>
<td>• You are using a modem connection (PPP) or SNMP.</td>
</tr>
<tr>
<td>• You are using an Ethernet network for communications.</td>
<td>• You are using event messages or email.</td>
</tr>
<tr>
<td>• The strategy handles all logic; you are not also configuring events and reactions on I/O units.</td>
<td>• You are configuring events and reactions on the I/O unit in addition to strategy logic.</td>
</tr>
<tr>
<td></td>
<td>• You are using OPC to communicate with I/O units.</td>
</tr>
<tr>
<td></td>
<td>• You are not using ioControl.</td>
</tr>
</tbody>
</table>

Whichever tool you use for configuring I/O, be aware of the impact if you later change configuration. For example, if you configure I/O in ioManager, download the configuration file to I/O units, and then later add a point in ioControl, remember that your configuration file doesn’t contain that point.
Using PPP Over a Modem

NOTE: This section applies only to SNAP Ultimate or SNAP Ethernet I/O units, not to SNAP Simple I/O units.

Use the rest of this chapter only if you have SNAP Ethernet-based I/O units installed at remote locations or in other places where an Ethernet network is not available, and you are using modems to communicate between the I/O unit and a PC. The modems use the point-to-point protocol (PPP) to communicate. You can set up communication so that the I/O unit can dial in to a PC, so that PCs can dial into the I/O unit, or both.

NOTE: You can communicate with a SNAP Ethernet or SNAP Ultimate I/O unit using a modem and PPP at the same time you are communicating with the I/O unit over an Ethernet network.
Here's how to set up PPP:

1. Use ioManager to assign an IP address to the SNAP Ethernet-based I/O unit, following instructions in the ioManager User's Guide.
2. Follow steps in the next section to configure PPP.
3. Attach the modem to the system, following the steps on page 16.
4. Set up Windows dial-up networking (page 17) or remote access server on the PC.

Configuring PPP on the I/O Unit

We recommend you use an Ethernet crossover cable initially to assign an IP address, configure points, store configuration to flash, and configure PPP. Instructions for doing all this are in the ioManager User's Guide. The instructions for configuring PPP are repeated here for convenience.

1. Choose Start > Programs > Opto 22 > ioProject Software > ioManager.
2. In the ioManager main window, click the Open button or choose File > Open.
3. In the Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.
4. In the configuration tree, right-click the name of the I/O unit on which you want to set up PPP and choose Configure from the pop-up menu.

5. Make sure the correct I/O unit is highlighted in the list. Click the Communications button and choose PPP from the pop-up menu.
6. Complete the fields as follows:

A Enter the Local IP Address for the PPP interface on the I/O unit. Enter the local Subnet Mask only if you are using classless IP addressing. If you are not using classless IP addressing, leave the Subnet Mask at zero, and the I/O unit will calculate the subnet mask.

**IMPORTANT:** The network address for the PPP interface must be different from the network ID for the Ethernet interface. (The network address is obtained by ANDing the IP address and the subnet mask.)

B Enter the maximum number of times a login/password combination can be retried.

C If you want outgoing PPP to always be connected, so there is no need for the I/O unit to dial out, check this box.

D Change the modem initialization string and modem hangup string if necessary. Make sure you use the setting to ignore DTR signal in the modem initialization string:

The default modem initialization string is `AT&D0^M----`

Consult the command reference that came with your modem to determine the correct initialization command strings. A sample modem initialization string might look like this:

```
AT&F^M~AT&D0^K0^M~AT&W0^M~AT&Y0^M~
```

The &F command sets the modem back to factory defaults. The ^M tells the Ethernet I/O unit to insert a carriage return. The ~ tells it to insert a 500ms pause. The &W0 writes the current settings to NVRAM profile 0 on the modem. The &Y0 instructs the modem to use NVRAM profile 0 after resetting.

This initialization string is just a sample; command strings for your modem may differ.

E If the I/O unit will send outgoing calls, complete the Outgoing PPP section:

Choose Enabled from the drop-down list.

In the Use Local IP Address field, choose Yes to have the I/O unit use the Local IP Address you entered for the PPP link; choose No to have the remote device assign the I/O unit an IP address for the PPP link. The default is No.
If you want the I/O unit to use the device the I/O unit is calling as the default gateway for all communication, choose Yes for Set As Default Gateway. The default is No.
Enter the Login and Password the I/O unit should use for authentication when it calls the remote device.
In the Phone number field, enter the number the modem should dial for outgoing calls from the I/O unit.
Change the following fields if necessary:

- **Inactivity Timeout**—If the I/O unit sends no packets and receives no packets for this number of seconds after the PPP session is negotiated, the modem will hang up. The default is 30.
- **Max Connect Time**—The maximum amount of time in seconds an outgoing PPP connection can stay connected after successful negotiation. Default is zero, which disables the timer.
- **Max Dial Retries**—The number of times the I/O unit will redial if the first attempt fails. Default is zero.
- **Retry Interval**—The number of seconds the I/O unit will wait before trying to redial after the first attempt fails. Default is zero.
- **Disable Time**—If the maximum connect time or maximum number of retries has been reached, the outgoing PPP dialer waits this number of seconds before doing anything. Default is zero.

If the I/O unit will receive incoming calls via modem, complete the Incoming PPP section:
Choose Enabled from the drop-down list so the modem will listen for incoming calls.
If you want the I/O unit to use the device calling the I/O unit as the default gateway for all communication, choose Yes for Set As Default Gateway. The default is No.
Change the Inactivity Timeout if necessary. The default is 30.
Enter the Login and Password the I/O unit should accept for incoming calls.
In the Remote IP Address field, enter the IP address the I/O unit should give to devices that dial into the I/O unit and ask for an address. This address must be on the same subnet as the local IP address.

Enter a modem listen string to make sure the modem automatically answers calls. The default modem listen string is `ATSO=1~M~`, which instructs the modem to answer any incoming calls on the first ring. Again, refer to your modem’s command reference for the correct listen string.

When all fields are correct, click OK.

**IMPORTANT:** For the configuration to take effect, you must upload the configuration file to the I/O unit, save it to flash memory, and restart the I/O unit.

Follow instructions in the [ioManager User’s Guide](#) to upload the configuration file to the brain.
If you wish, you can upload just once, after you have configured all items for the I/O unit: PPP, I/O points, security, and so on.

Continue with the next section to attach the modem to the I/O unit.
Attaching the Modem to the SNAP Ethernet-Based I/O Unit

Once the brain and I/O points are configured and communication has been tested, follow these steps to attach the modem to the I/O unit. To work properly with the I/O unit, a modem must be able to store settings in non-volatile RAM (NVRAM) and default to those settings on reset.

1. Follow the diagram at right to attach the modem to the I/O unit using the brain’s serial connector.
2. Store configuration settings to the modem’s NVRAM, following instructions in the user’s guide for your modem.

   NOTE: Configuration settings must be stored to the modem’s NVRAM so they will be loaded when the SNAP Ethernet-based I/O unit sends a reset command to the modem.

3. If PCs will dial up the I/O unit, set up Windows dial-up networking on the PCs that will call the I/O unit. For Windows 2000, see page 17.
4. If you want the I/O unit to dial up a PC, set up a remote access server (RAS) on the PC.

Configuring Microsoft Windows Dial-up Networking on Windows 2000

Use the following settings to configure Windows dial-up networking on any PC that will dial in to the SNAP Ethernet-based I/O unit.

2. Double-click Make New Connection. Follow directions in the wizard to create a new connection.
3. When the new connection is created, double-click its name in the Network and Dial-Up Connections window.
4. In the Properties dialog box, set each tab as shown in the following figures:
General Tab

Connect using:
- Modem - Courier V.Everything External (COM1)

Phone number:
- Phone number: 9, 8953032
- County/region code:
- Use dialing rules
- Show icon in taskbar when connected

Hardware features:
- Enable hardware flow control
- Enable modem error control
- Enable modem compression

Initialization:
- Show terminal window
- Run script

Enable modem speaker

Maximum speed (bps): 19200
Modern protocol:

OK | Cancel
CHAPTER 2: INSTALLING A SNAP ETHERNET-BASED I/O UNIT

Options Tab

Security Tab
Networking Tab

Sharing Tab
System Architecture

This chapter explains how to use SNAP Ethernet-based I/O units in an Ethernet network and how to communicate with them. It includes information on:

- Communication options See below
- System architecture See page 24
- Networking See page 32
- Specifications and feature comparison charts See page 35

IMPORTANT: The SNAP Ultimate, SNAP Ethernet, and SNAP Simple I/O units covered in this guide are no longer recommended for new development. Because they have reached their hardware limits, we have had to replace them with new SNAP PAC products.

SNAP PAC controllers and I/O processors are more powerful, include additional functionality, and are generally less expensive than the older units. Please see our website, www.opto22.com, or call us at 800-321-6786 or 951-695-3000 for information about SNAP PAC controllers and brains.

Communication Options

SNAP Ethernet-based I/O units communicate using TCP/IP or UDP/IP over a wired or wireless network.

**Physical Layer**—All SNAP Ethernet-based I/O units communicate over a 10- or 100-Mbps wired Ethernet link. SNAP Ethernet and SNAP Ultimate I/O units can also communicate using a modem over PPP.

**Transport Layer**—The key to SNAP Ethernet-based I/O unit communication flexibility is the transport layer, Internet Protocol (IP). Both the Transmission Control Protocol (TCP) and the User Datagram Protocol (UDP) are used with IP.

**Application Layer**—Because SNAP Ethernet-based I/O units use standard IP for the transport layer, many communication options are possible in the application layer. After the I/O unit is installed and has an IP address assigned (see page 10), you can communicate with it using the following methods:
COMMUNICATION OPTIONS

- **ioManager** software utility is used for assigning IP addresses, configuring I/O points and features, and performing onetime reads and writes. (The newer PAC Manager 8.x software can also be used with these I/O units.)

- **ioControl** strategies running on a SNAP PAC controller, a SNAP Ultimate I/O system, or a SNAP-LCE controller can configure, read, and write to I/O points on SNAP Ultimate, SNAP Ethernet, or SNAP Simple I/O units. (NOTE: Strategies created in the newer PAC Control 8.x software and running on a SNAP PAC controller can support SNAP Ultimate, Ethernet, and Simple I/O units with version 7.1 firmware, but support is more limited than for SNAP PAC I/O units with 8.0 firmware. SNAP PAC hardware and PAC Project software are recommended for new development.)

- **Custom software applications** are easy to develop using our OptoMMP Communication Toolkit with ActiveX components and C++ classes. They use the OptoMMP protocol, an IEEE 1394-based protocol, to read and write to SNAP Ethernet-based I/O units. For developers not using Microsoft Windows, our OptoMMP protocol is open and documented.

- **Modbus/TCP** provides a direct connection with Modbus/TCP hardware or software or third-party software applications, which can read or write to I/O points on SNAP Ethernet-based I/O units.

- **OPC** (OLE for Process Control) uses OptoOPCServer to serve I/O unit data to any OPC 2.0-compliant application, such as an HMI, which can also read or write to I/O points. OptoOPCServer can be purchased separately or as part of the ioProject Professional software suite.

- **SMTP** (Simple Mail Transfer Protocol) connects a SNAP Ultimate or SNAP Ethernet I/O unit with corporate email servers, so employees can be emailed or paged if there’s a problem on devices attached to the I/O unit.

- **SNMP** (Simple Network Management Protocol) makes it possible to monitor devices attached to SNAP Ultimate or SNAP Ethernet I/O units just as you would any computer or server on the Ethernet network, using an SNMP-based enterprise management system such as Computer Associates’ Unicenter®, Hewlett-Packard’s OpenView®, or IBM’s Tivoli®. When a monitored event occurs, such as a door left open or a pressure level too high, the I/O unit sends an SNMP trap to the management system.

- **FTP** (File Transfer Protocol) can be used to transfer files and data to and from the SNAP Ultimate I/O system, whether to custom applications, enterprise databases, or any file system.

- **OptoControl™** strategies running on a SNAP-LCM4 industrial controller with an M4SEN100 Ethernet adapter card can configure, read, and write to I/O points on SNAP Ethernet or SNAP Simple I/O units. (NOTE: OptoControl and the FactoryFloor software suite are not recommended for new development.)

### Simultaneous Communication

In addition to communicating using all the methods listed above for the type of I/O unit, each SNAP Ethernet-based I/O unit can also communicate simultaneously using all applicable methods. The reason lies in the nature of IP. In serial communication, a single data request is sent by one device to another. The first device must wait for a response before any additional communication can be carried out. IP, however, can establish multiple simultaneous sessions, so many data requests
can be sent at once without waiting for any individual response. Each request gets a response, but
the link isn’t idle while waiting for responses.

In addition, IP can simultaneously handle multiple requests from multiple devices. A PC can
communicate with all SNAP Ethernet-based I/O units on the same network—all at the same time—and multiple PCs can communicate with one I/O unit at the same time.

So, for example, a SNAP Ethernet-based I/O unit can respond to directions from a Modbus master,
give analog point data to a technician using ioManager, and carry out instructions from a custom
C++ application—all at once.

## Accessing SNAP Ethernet Systems I/O Units Over the Internet

Since SNAP Ethernet-based I/O units are just like any other hardware on the Ethernet network, you
can access them over the Internet in exactly the same way you would access a computer. The details
depend on your network and Internet connection. Consult your system or network administrator or
your Internet Service Provider (ISP) for more information.

## Choosing Communication Methods

How do you need to communicate with SNAP Ethernet-based I/O units to match the tasks your
application requires? Check the following table for help in choosing communication methods and
finding out where to look for more information on them.

<table>
<thead>
<tr>
<th>This task</th>
<th>Can be done using these methods</th>
<th>Details and references for information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure I/O units.</td>
<td>ioControl (I/O points only) or ioManager (I/O points and other functions)</td>
<td>If you are using ioControl, configure the system in ioControl. See the ioControl User’s Guide. For the Communication Toolkit or OptoMMP protocol, see OptoMMP Protocol Guide.</td>
</tr>
<tr>
<td>Monitor and control processes.</td>
<td>ioControl flowchart logic</td>
<td>ioManager Inspect window or OptoMMP Communication Toolkit or OptoMMP protocol</td>
</tr>
<tr>
<td>Send email to or page someone. Send SNMP trap.</td>
<td>ioManager (for configuration). ioControl</td>
<td>OptoMMP Communication Toolkit or OptoMMP protocol</td>
</tr>
<tr>
<td>Give technicians an Opto 22 HMI with alarming and trending.</td>
<td>ioDisplay</td>
<td></td>
</tr>
<tr>
<td>Monitor and control Ethernet-based I/O units on the network.</td>
<td>ioControl</td>
<td>OptoControl (SNAP Ethernet or SNAP Simple I/O only)</td>
</tr>
</tbody>
</table>
**System Architecture—SNAP Simple I/O**

SNAP Simple I/O can be used in two ways:

- As part of a larger control system:
  - A system running ioControl (on a SNAP PAC or SNAP-LCE controller or on SNAP Ultimate I/O)
  - A system running OptoControl on a legacy SNAP-LCM4 controller with an M4SENET-100 Ethernet adapter card (not recommended for new installations; use ioControl and a SNAP PAC controller instead)

- As an independent I/O unit. You can communicate with an independent Simple I/O unit using Modbus/TCP, the OptoOPCServer (available separately), or applications you develop using the free OptoMMP Communication Toolkit or our OptoMMP protocol.

The following diagrams illustrate these two uses.

**SNAP Simple I/O as Part of a Larger SNAP System:**
SNAP Simple I/O as an Independent I/O Unit:

- As part of a larger control system:
  - A system running ioControl (on a SNAP PAC or SNAP-LCE controller or on SNAP Ultimate I/O)
  - A system running OptoControl on a legacy SNAP-LCM4 controller with an M4SENET-100 Ethernet adapter card (not recommended for new installations; use ioControl and a SNAP PAC controller instead)
- As an independent I/O unit—You can communicate with an independent SNAP Ethernet I/O unit using Modbus/TCP, the OptoOPCServer, SNMP, SMTP, or applications you develop using the free OptoMMP Communication Toolkit or our OptoMMP protocol.

System Architecture—SNAP Ethernet I/O

Like SNAP Simple I/O, SNAP Ethernet I/O can be used as part of a larger control system or as an independent I/O unit.

- As part of a larger control system:
  - A system running ioControl (on a SNAP PAC or SNAP-LCE controller or on SNAP Ultimate I/O)
  - A system running OptoControl on a legacy SNAP-LCM4 controller with an M4SENET-100 Ethernet adapter card (not recommended for new installations; use ioControl and a SNAP PAC controller instead)
- As an independent I/O unit—You can communicate with an independent SNAP Ethernet I/O unit using Modbus/TCP, the OptoOPCServer, SNMP, SMTP, or applications you develop using the free OptoMMP Communication Toolkit or our OptoMMP protocol.

System Architecture—SNAP Ultimate I/O

*NOTE: The SNAP Ultimate brain was a forerunner to the SNAP PAC R-series controller. Although still available, the Ultimate brain is not recommended for new applications. Instead, use SNAP PAC controllers; they are more powerful and less expensive.*
Understanding the SNAP Ultimate Brain

Because SNAP Ultimate brains are a combination of controller and I/O processor, their architecture is more complex than that of SNAP Simple and SNAP Ethernet brains, which are I/O processors only. The SNAP Ultimate brain merges two functions that are usually located in separate pieces of hardware: input/output processing and flowchart-based control. These two functions are handled by two “sides” of the brain, as illustrated in the next diagram.

The I/O Side of the Brain

The brain reads and writes to the I/O points using its I/O side memory map. This side of the SNAP Ultimate brain is like SNAP Ethernet and SNAP Simple brains.

You can think of the brain’s memory map as a grid of mailboxes, with each mailbox having its own memory address. Each mailbox address has a specific purpose. For example, one address holds the state of a single digital point; another address holds counter data for the same point. There’s an address that stores the brain’s firmware version, one that contains the minimum value of a specific analog point, and many more. If you are familiar with programmable logic controllers (PLCs), you’ll see that the memory map is similar to a register.

Most SNAP Ultimate I/O units run ioControl flowcharts that automatically manipulate the memory map, so you probably won’t need to understand it in detail. If you do need to refer to it, however, the complete list of memory map addresses is in Opto 22 form 1465, the OptoMMP Protocol Guide.

The Control Side of the Brain

The control side of the brain is like a traditional Opto 22 industrial controller. In the control side, the brain runs ioControl flowcharts. These flowcharts provide the logic that controls processes through the system. Commands within the flowchart read from and write to the memory map in the I/O side of the brain in order to monitor and control the I/O points.
Controlling the System

The flowcharts that run in the control side of the brain are created in ioControl, a software application included with the SNAP Ultimate I/O system. You create these flowcharts as part of a control strategy and download the strategy to the brain, and the brain runs it independently. (For information on using ioControl, see form 1300, the ioControl User’s Guide, and form 1301, the ioControl Command Reference.)

You use ioControl on a PC connected to the network, so you can create your control strategy and download it to the brain. Also included with the SNAP Ultimate I/O system is ioDisplay, a full-featured human-machine interface (HMI). ioDisplay uses the same tag database as ioControl, so points and variables are already defined. Operators, technicians, and engineers running ioDisplay on a Microsoft Windows-based PC on the Ethernet network can see the information they need, as well as plot trends and respond to alarms.

For applications that require more than one I/O unit, the SNAP Ultimate brain can control multiple SNAP Ethernet, SNAP Simple, and SNAP Ultimate I/O units through the flowcharts on its control side. These I/O units can be located where needed on the Ethernet network for distributed control.

The following diagram shows the control side of the brain:
Communicating Peer-to-Peer on the Network

What if you have more than one SNAP Ultimate I/O unit, or multiple SNAP PAC and SNAP-LCE controllers? What if each one is running a different ioControl strategy, and they need to share variable data?

The following illustration shows how this type of peer-to-peer communication can be done.

The memory map in the brain’s I/O side has two parts: the fixed area and the Scratch Pad area. The fixed memory area is used automatically by the brain to read and write data to I/O points; each address has a fixed purpose. The Scratch Pad area, however, is user-defined; it is available for you to define and use as needed in order to exchange data among peers. The Scratch Pad area includes four sections to accommodate different types of data: bits, integers, floats, and strings. The bit section is a 64-bit mask. Integer and float sections are tables of 10,240 four-byte elements. Strings are a table of 64 elements, each capable of holding 128 characters or 128 bytes of binary data.

Using ioControl commands in its flowcharts, the first Ultimate I/O unit can write strategy variable data to its Scratch Pad area. Other SNAP Ultimate I/O units, SNAP PAC or SNAP-LCE controllers, or even legacy SNAP-LCM4 controllers can use similar commands in their own flowcharts to read the data from the Scratch Pad area of the first one. Similarly, another unit or controller can write to the Scratch Pad area of the first one, which can then read the data deposited in its own Scratch Pad area by the peer. The reading and writing of data by peers to the Scratch Pad area must be very carefully coordinated in order to avoid conflicts.

For more information on using ioControl commands for peer-to-peer communication, see “Communication Commands” in Chapter 10 of the ioControl User’s Guide and individual commands in the ioControl Command Reference.
Communicating with Enterprise Systems and Third-Party Software

In addition to I/O, control, and peer-to-peer communication, the SNAP Ultimate I/O system can also interface directly with enterprise systems and third-party software that need to use its data. The following graphic shows how these software applications (and some hardware, too) can directly access the memory map in the brain’s I/O side for both I/O point data and strategy variable data.

All of the protocols shown in the diagram, except FTP, can be used to communicate with both the fixed memory map area and the Scratch Pad area, so you can access both I/O point data in the fixed area and strategy variable data placed in the Scratch Pad area. In addition, strategy variable data from the ioControl database can be directly used by OPC clients.

FTP can be used to access files on the SNAP Ultimate I/O unit, which are on the control side but can contain data from the I/O side (or any other data). For more information on the I/O unit’s file system and FTP, see the ioControl User’s Guide and the ioManager User’s Guide.

The Complete System

The complete system is illustrated below.
Since all protocols can be used simultaneously, while the strategy is running on the control side of the brain and peer-to-peer communication is going on, coordination in reading and writing to memory map areas is critical to avoid conflicts. The more capabilities of the system you use, the more careful you
Networking

From a physical standpoint, SNAP Ethernet-based I/O units can be networked in several ways:

- Connected directly to a PC or controller using a crossover cable
- Attached to an existing TCP/IP Ethernet network
- As part of an independent network built with standard Ethernet hardware
- Over a modem connection (SNAP Ethernet and SNAP Ultimate I/O units only)

The networking method you use depends on several things, including whether you need control or data acquisition, the number of PCs and I/O units you are using, the speed and volume of communication, security requirements, and the availability of an Ethernet network.

Connecting the I/O Unit Directly to a PC or Controller

A direct connection using a crossover cable connects just one SNAP Ethernet-based I/O unit with one host. If you need only one I/O unit and one host and have no existing Ethernet network, it’s ideal. A direct connection is quick, easy to do, and provides high speed and high security for a small system.

A direct connection is also useful for assigning an IP address, configuring I/O points, and testing applications on I/O units that will be used later on a network. The direct connection eliminates other variables that could interfere with communication, so you can focus on maintenance and troubleshooting.

Crossover Cables

Use an Ethernet crossover cable for direct connections. The crossover cable must be a minimum of one meter long. (Maximum length is 100 meters.) For reliability, we recommend you purchase the cable, rather than build it.

If you build your own crossover cable, you’ll need an RJ-45 male connector at each end. The cable includes four twisted pairs. Follow the illustration on the next page for wiring the connectors.

NOTE: The illustration shows both a straight-through cable and a crossover cable. The straight-through cable is used for connecting the brain to a hub on a standard Ethernet network. The crossover cable is used for direct connection to a PC or other host.

If you’re not sure which cable you have, hold up both ends so the connector tab is at the back of each end. Compare the color sequence of the wires in the connectors. If the sequence is identical for both connectors, it’s a straight-through cable. If the sequence is different, it’s a crossover cable.
NOTE: Make sure you put 3 and 6 on the same pair, or you may experience noise and distance limitations. Also, make sure to include all pairs, since they are required for 100 Mbps.

**Attaching the I/O Unit to an Existing Ethernet Network**

The first rule in attaching SNAP Ethernet-based I/O units to an existing network is to work closely with your system administrator, who must determine network topology and hardware. Be sure to consider the impact on your existing network of adding the I/O units.

In addition, make sure the system administrator understands that each I/O unit must have a fixed (static) IP address, whether or not a Dynamic Host Configuration Protocol (DHCP) server is used on the network. For more information on IP addresses, see the ioManager User’s Guide.

If you are using SNAP Ethernet-based I/O units for data acquisition, you can place the I/O unit anywhere on an existing Ethernet network. If you are using the I/O unit with control applications, however, the network segment design will depend on the number of hosts, the number of data transactions, and issues of data security. With fewer hosts and fewer data transactions, data packet collisions are less likely and system performance improves. If collisions are a problem, and especially if you need high throughput and predictable response times, it’s best to put the I/O unit on a switched network segment. We recommend switches, not hubs. For best performance, use a 100 Mb network.

If you need to isolate the control system data from the main network backbone, consider using a router, network switch, or other gateway device. You can also use a SNAP PAC S-series controller, which has two Ethernet network interfaces: one interface can be connected to the enterprise network, and the other used for the control system. (For more information, see the SNAP PAC S-Series data sheet, form #1584).
Using the I/O Unit in an Independent Network

The third way SNAP Ethernet-based I/O units can be used is by developing an independent network. An independent network gives a high level of communication speed and volume, as well as high security. If you have no existing Ethernet network, you can use off-the-shelf Ethernet components to build one.

You may also need a separate network for critical control applications. Again, the choice depends on your requirements for data transactions, data security, and whether a near-deterministic system is necessary.

If you are building your own network, remember that each I/O unit must have a fixed IP address. See the ioManager User’s Guide for more information on IP addresses.

Since Ethernet and TCP/IP are worldwide standards, there are a number of commercially available resources for learning about building and maintaining such a network. One excellent resource is the MCSE Training Guide: TCP/IP by New Riders Publishing; many others are also available. We strongly suggest you learn as much as possible about the subject and plan your network carefully before beginning, in order to get the best performance from your system.

Communicating with the System via Modem

A fourth way to use a SNAP Ethernet-based I/O unit (SNAP Ultimate and SNAP Ethernet I/O only) is with a modem connection. This use is ideal for remote installations (for example, a communication tower or a pipeline) or in other places where a wired Ethernet network is not practical. Communication via modem uses the Point-to-Point Protocol (PPP) over an RS-232 link instead of an Ethernet link.

The system can dial out to a PC connected to a modem, or the PC can dial into the system, or both. If the system is also communicating via Ethernet, the network ID for the PPP interface on the brain must be different from the brain’s Ethernet IP network ID.

For more details on configuring the brain for use with a modem, see “Using PPP Over a Modem” on page 12.
Specifications

Specifications for SNAP Ethernet-Based Brains

The following table shows specifications for all SNAP Simple, SNAP Ethernet, and SNAP Ultimate brains:

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Requirements</td>
<td>5.0 VDC to 5.2 VDC at 1.0 A maximum (does not include module power requirements)</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>0 to 60 °C (UIO)</td>
</tr>
<tr>
<td></td>
<td>0 to 70 °C (EIO and SIO)</td>
</tr>
<tr>
<td>Storage Temperature</td>
<td>-40 to 85 °C</td>
</tr>
<tr>
<td>Humidity</td>
<td>0–95% humidity, non-condensing</td>
</tr>
<tr>
<td>Network Interface</td>
<td>IEEE 802.3 network, 10Base-T and 100Base-TX</td>
</tr>
<tr>
<td>Serial Port</td>
<td>RS-232*</td>
</tr>
<tr>
<td>Serial Data Rates</td>
<td>Default is 19,200 baud; baud rate is soft-selectable from 2400 to 115,200 baud.</td>
</tr>
<tr>
<td>Maximum Ethernet Segment Length</td>
<td>100 meters with Category 5 or superior UTP. For 100 Mbps at this distance, use Category 5 or superior solid UTP.</td>
</tr>
<tr>
<td>Jumpers (Internal)</td>
<td>Boot to kernel/boot to loader</td>
</tr>
<tr>
<td></td>
<td>Reset to factory defaults</td>
</tr>
<tr>
<td>SNAP Ultimate Brain Ethernet Host Connections</td>
<td>Maximum 31 connections to port 22001 (control side) and 15 connections to port 2001 (I/O side). Host performance may deteriorate near maximums.</td>
</tr>
</tbody>
</table>

*The serial connector on SNAP Ethernet-based brains is used for programming and maintenance. On SNAP Ethernet and SNAP Ultimate brains, it can also be used for a modem connection using PPP. On SNAP Ultimate brains, this connector can also be used for a direct connection to a serial device; communication is handled through ioControl.

LED Descriptions

All Brains Except SNAP-ENET-S64

The following table describes LEDs on most SNAP Ethernet-based brains. A SNAP Ultimate brain is shown as an example.

<table>
<thead>
<tr>
<th>LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACT</td>
<td>Network Activity</td>
</tr>
<tr>
<td>FD</td>
<td>Full Duplex Mode</td>
</tr>
<tr>
<td>ERD</td>
<td>Ethernet—Receive Data</td>
</tr>
<tr>
<td>ETD</td>
<td>Ethernet—Transmit Data</td>
</tr>
<tr>
<td>10MB</td>
<td>Ethernet Link Detection at 10 Mbps</td>
</tr>
<tr>
<td>100MB</td>
<td>Ethernet Link Detection at 100 Mbps</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN</td>
<td>Normal Operation</td>
</tr>
<tr>
<td>3VF</td>
<td>3 Volt Fault</td>
</tr>
<tr>
<td>5VF</td>
<td>5 Volt Fault</td>
</tr>
<tr>
<td>FLT</td>
<td>Microprocessor Fault</td>
</tr>
<tr>
<td>SRD</td>
<td>Serial—Receive Data</td>
</tr>
<tr>
<td>STD</td>
<td>Serial—Transmit Data</td>
</tr>
</tbody>
</table>
SNAP-ENET-S64 Brains

The following table describes LEDs on SNAP-ENET-S64 brains.

<table>
<thead>
<tr>
<th>LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERD</td>
<td>Ethernet—Receive Data</td>
</tr>
<tr>
<td>FD</td>
<td>Full Duplex Mode</td>
</tr>
<tr>
<td>SRD</td>
<td>Serial—Receive Data</td>
</tr>
<tr>
<td>PWR</td>
<td>Power On</td>
</tr>
</tbody>
</table>

Feature Comparisons

Although SNAP Ultimate I/O, SNAP Ethernet I/O, and SNAP Simple I/O share many of the same features, the families and brain models within them do have different capabilities. This section compares features to help you use hardware to its fullest capacity, based on your needs.

For descriptions of features, see page 39.
SNAP Ethernet-Based Brain Comparison Chart

This table compares Opto 22 Ethernet-based brains: SNAP Simple, SNAP Ethernet, and SNAP Ultimate.

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>SNAP Simple I/O</th>
<th>SNAP Ethernet I/O</th>
<th>SNAP Ultimate I/O</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O modules supported</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4-channel digital</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>High-density digital (&gt;4 channels)</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>2- and 4- channel analog</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>8-channel analog</td>
<td>●</td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Serial communication modules (RS-232, RS-485/422, Profibus®, Wiegand®)</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Digital I/O points</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input latching</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>On/off status</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Watchdog timer¹</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>High-speed counters (20 kHz)¹</td>
<td>●</td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Quadrature counters²</td>
<td>●</td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>On-pulse and off-pulse measurement¹,³</td>
<td>●</td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>TPO (time-proportional output)³</td>
<td>●</td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Pulse generation (N pulses, continuous square wave, on-pulse, and off-pulse)³</td>
<td>●</td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Analog I/O points</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thermocouple linearization (32-bit floating point for linearized values)</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Minimum/maximum values</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Offset and gain</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Scaling</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Time-proportional output</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Output clamping</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Filter weight</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Watchdog timer</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Ramping³</td>
<td>●</td>
<td></td>
<td>●</td>
</tr>
<tr>
<td>Serial events</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>PID logic on the brain</td>
<td>16 PIDs</td>
<td>32 PIDs</td>
<td>32 PIDs</td>
</tr>
<tr>
<td>Digital events¹</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Alarm events</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Timers¹</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>
### FEATURE COMPARISONS

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>SNAP Simple I/O</th>
<th>SNAP Ethernet I/O</th>
<th>SNAP Ultimate I/O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event messages</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>UDP Streaming</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Email (SMTP client)</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>OPC driver</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Data logging in the brain</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Security (IP filtering, port access)</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Realtime clock (RTC)</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>I/O point data mirroring</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Memory map copying</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Scratch Pad area—bits</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Scratch Pad area—bits, floats, integers, strings</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>SNMP (network management of I/O &amp; variables)</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>PPP (dial-up and radio modems)</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>FTP server and client</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Modbus/TCP</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Ethernet network</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Serial (RS-232)</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Runs ioControl strategies</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>ioControl compatibility (using SNAP PAC or SNAP-LCE controller or SNAP Ultimate I/O)</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>OptoControl compatibility (using Opto 22 controller with Ethernet card. Not for new development.)</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Mounting rack</td>
<td>SNAPP-M racks</td>
<td>SNAPP-B racks</td>
<td>SNAPP-D64 racks</td>
</tr>
<tr>
<td>Number of modules per mounting rack</td>
<td>4, 8, 12, or 16</td>
<td>4, 8, 12, or 16</td>
<td>16</td>
</tr>
<tr>
<td>Maximum number of modules allowed per I/O unit (with largest rack)</td>
<td>16 4-ch dig 16 HDD 16 analog 8 serial</td>
<td>8 4-ch dig 16 HDD 8 serial</td>
<td>16 4-ch digital 16 HDD 16 analog 8 serial</td>
</tr>
</tbody>
</table>

1 Four-channel digital modules only; not available on high-density digital modules
2 Requires a SNAP quadrature input module (SNAP-IDC5Q)
3 Available when used with ioControl Professional and a SNAP PAC controller
4 Applies to SNAP-ENET-RTC, not to SNAP-B3000-ENET
5 High-density digital
Additional Information on Features

Digital Point Features

For information on configuring digital point features, see the *ioManager User’s Guide*.

**Latches**—When the value of a digital input point changes from off to on, an on-latch is automatically set. While the value of the point may return to off, the on-latch remains set until cleared, as a record of the change. Similarly, an off-latch is set when the value of a digital point changes from on to off, and it remains set until cleared. Latching is automatic and needs no configuration.

**Watchdogs**—You can set a watchdog to monitor communication with the PC or other host device. If the host does not write data to the I/O unit for the length of time set in the watchdog, the I/O unit automatically sets designated digital and analog I/O points (but not points on high-density digital modules) to the values you have determined. This action makes sure the process is brought to a safe state if communication fails.

**High-speed counters** (Some brains only; see chart on page 37.)—Any digital input (on 4-channel and high-density modules) can be used as a counter, counting the number of times the input changes from off to on. The speed of the counter depends on the module. You must configure the digital points you want to use as counters. Points on 4-channel modules are activated as soon as configured; points on high-density modules are always activated (but you must still configure them as counters in order to use ioControl commands with them).

**Quadrature counters** (Some brains only; see chart on page 37.)—When you configure points on a quadrature input module, the quadrature counter feature is automatically included. You can read the quadrature count from either point by reading the point’s counter data.

**Additional digital features**—The following digital features are available on some brains (see chart on page 37) but only when the brain is used with a SNAP PAC controller and ioControl Professional. These features are not currently available through ioManager or the memory map. Use ioControl commands to configure and access them. See the *ioControl User’s Guide* for more information.

- *On-pulse and off-pulse measurement*—A pulse is a brief on (or off) state, usually repeated at a specific interval. The brain can measure the first pulse, that is, the amount of time the input stays on (or stays off).
- *TPO (time-proportional output)*—Time-proportional output varies the duty cycle and the percentage of on time within that cycle. TPO is often combined with a PID loop and used to control the output, for example in a heater or oven.
- *Pulse generation*—Includes continuous square waves, on-pulses, off-pulses, and N pulses. A pulse turns a digital output on (or off) briefly, either once or for a specified number of times at a specified interval. A digital square wave is a specific pattern of on and off states, repeated continuously.

Analog Point Features

These features apply to some brains only; see chart on page 37. For information on configuring analog features, see the *ioManager User’s Guide*.

**Watchdogs**—You can set a watchdog to monitor communication with the PC or other host device. If the host does not write data to the I/O unit for the length of time set in the watchdog, the I/O unit automatically sets designated I/O points to the values you have determined. This action makes sure the process is brought to a safe state if communication fails.
Scaling — You can scale analog input or output points so that the values make sense for your situation. For example, you can scale a -5 V to +5 V input point to show 0% to 100%.

Minimum and maximum values — The I/O unit automatically keeps track of minimum and maximum values. You can read these values at any time, for example, to record minimum and maximum temperatures. You can also reset min/max values. For example, if you want to record the maximum temperature at point 2 in each 24-hour period, you must reset the values after they are read each day.

Offset and gain — The brain can calculate offset and gain for analog input points. If a -50 mV to +50 mV input receives signals that are slightly off (not exactly -50 mV at the lowest point, for example), the offset and gain can be calculated so that values will appear accurately when read.

NOTE: If you are using Modbus/TCP, you will need to calculate the offset and gain yourself. Then you can write offset and gain values to the brain.

Output clamping — The I/O unit can clamp values sent to analog output points so they do not go above or below a specific limit. For example, if you are using a 0–10 VDC output module, but the device attached to one of its points can only handle a maximum of 5 VDC, you can set an upper clamp of 5 VDC for that point. The values for upper and lower clamp are set in engineering units.

Average filter weight — The I/O unit can use a filter weight to smooth analog input signals that are erratic or change suddenly. See details in the ioManager User’s Guide.

Ramping — Some devices attached to analog outputs should not be abruptly stepped up or down, because a sudden change might damage the equipment or cause other problems. Instead, you can gradually ramp the device up or down to the desired value. IMPORTANT: Ramping is available on some brains (see chart on page 37) but only when used with a SNAP PAC controller and ioControl Professional. Ramping is not currently available through ioManager or the memory map. Use ioControl commands to ramp an analog output. See the ioControl User’s Guide for more information.

Serial Communication

These features vary by brain model; see chart on page 37.

Serial communication generally occurs through SNAP serial communication modules. Most serial modules provide two channels of serial data, typically used to interface with printers, scales, chart recorders, barcode readers, or Wiegand® security devices. A Profibus module provides one channel of data from Profibus DP devices.

SNAP Simple I/O provides tunneling capability only, sending and receiving data from serial devices attached to the module. SNAP Ethernet and SNAP Ultimate I/O also provide full serial events. (See “Events, Timers, Event Messages, Email, Data Logging, Data Mirroring, and Memory Map Copying” on page 41 for more information.)

In addition, SNAP Ultimate brains can communicate directly to a serial device using the RS-232 connector on top of the brain. Communication is handled through ioControl commands. See “Communication Commands” in Chapter 10 of the ioControl User’s Guide.

PID Loops

These features apply to some brains only; see chart on page 37.

Proportional integral derivative (PID) loops are used to drive a variable, often from an analog input, toward a desired value. The PID monitors the variable, compares it to the setpoint (the desired value) and calculates an output that will push the variable very close to the setpoint. Temperature control is a typical application for a PID.
Each SNAP Ultimate brain can run up to 32 PID loops; each SNAP Ethernet brain can run up to 16 PID loops. To use PID loops, configure them in ioControl or ioManager, and use ioControl tuning tools for ease in debugging. See Opto 22 form #1300, the ioControl User’s Guide, for more information.

NOTE: PID capabilities in SNAP Ethernet I/O units are compatible with ioControl, but not with OptoControl.

Events, Timers, Event Messages, Email, Data Logging, Data Mirroring, and Memory Map Copying

These features apply to some brains only; see chart on page 37. They do not apply to high-density digital modules.

A SNAP Ultimate or SNAP Ethernet I/O unit can be configured to recognize one or a combination of the following as an event:

- The state of a point on a 4-channel digital module (on or off)
- A specific high or low value of an analog point, in Engineering Units
- A specific number on a digital counter or a high or low number on a quadrature counter
- An analog point value or a quadrature counter that is outside an allowable range
- The state of a bit in the Scratch Pad (on or off)
- A specific string received by a serial module.

The brain can react automatically to an event in any or all of the following ways:

- Turning points on 4-channel digital modules on or off (on the same or a different brain)
- Copying data from one memory map location to another on the same or a different brain
- Logging data
- Turning a bit in the Scratch Pad on or off
- Sending a stream packet
- Sending an email message
- Sending a string through a serial module to a serial device
- Sending an SNMP trap.

In addition, you can use a timer to set up a delay between when the event occurs and the reaction takes place.

For more information on configuring and using events and reactions, see the ioManager User’s Guide.

UDP Streaming

Most communication involves the two-step process of request and response. A faster way of getting information from an Ethernet-based I/O unit, however, is by streaming data. Streaming does not use TCP; it uses the User Datagram Protocol (UDP) instead. The I/O unit sends data at regular intervals to specified IP addresses. The communication is one-way; the I/O unit does not wait for a response.

You will need to write your own application in order to receive streamed data from the I/O unit. For more information on streaming, see Opto 22 form #1465, the OptoMMP Protocol Guide.

Security

You can use ioManager to limit access to Ethernet-based I/O units, either by allowing access only from specific computers or other devices on the network (IP filtering), or by limiting access to
specific protocols, such as SNMP, that are used with the I/O unit (port access). See the ioManager User’s Guide for more information on security.

**Scratch Pad Areas**

SNAP Simple I/O brains do not have Scratch Pad areas.

SNAP Ethernet brains have Scratch Pad bits only; they are used primarily for event/reactions. See the ioManager User’s Guide for more information.

SNAP Ultimate brains have Scratch Pad bits, integers, floats, and strings. These Scratch Pad areas are used primarily for peer-to-peer communication with other SNAP Ultimate I/O units and SNAP controllers on the network. See the ioControl User’s Guide for more information.

**SNMP**

The Simple Network Management Protocol (SNMP) is used to communicate with an SNMP-based enterprise management system, such as Computer Associates’ Unicenter, Hewlett-Packard’s OpenView, or IBM’s Tivoli. These enterprise management systems can manage analog, digital, or serial devices through a SNAP Ultimate or SNAP Ethernet I/O system just as they manage computer equipment on the Ethernet network.

See the ioManager User’s Guide to configure the SNMP agent, establish community groups and management hosts, and set up SNMP traps.

**PPP**

Point-to-point protocol (PPP) is used to communicate to a SNAP Ethernet or SNAP Ultimate I/O unit through a modem. If you have these I/O units installed at remote locations or in other places where an Ethernet network is not available, you can set up communication so that the I/O unit can dial in to a PC, so that PCs can dial into the I/O unit, or both. See “Using PPP Over a Modem” on page 12 for more information.

**FTP Server/Client**

(SNAP Ultimate brains with firmware versions 5.0 or newer) These brains have a substantial area available for file storage, and data can be easily moved to and from these files using FTP. For more information on the file system, see the ioManager User’s Guide.
Maintaining the Ethernet-Based I/O Unit

Introduction

This chapter includes step-by-step procedures for maintaining SNAP Ethernet-based I/O units, including:

- Changing IP addresses: See below
- Viewing IP addresses: See page 47
- Resetting the brain to factory defaults: See page 50
- Loading new firmware: See page 51

Backup Battery

The SNAP-ENET-RTC brain has a replaceable backup battery, Opto 22 part number RTCBATT. This part can be ordered from our website, www.opto22.com.

The backup batteries in SNAP Ultimate brains are not user-replaceable. Their expected lifetime is 6–10 years of backup with power off.

Changing or Viewing the IP Address

Each SNAP Ethernet-based I/O unit must be assigned an appropriate IP address and subnet mask for your network. See the ioManager User’s Guide for more information about IP addresses and instructions to assign them.

If you need to change an IP address or subnet mask, or if you don’t know an I/O unit’s IP address and need to view it, you can do so using ioManager.
Changing the IP Address

Brains with Firmware Version 5.0 or Newer

If your SNAP Ultimate or SNAP Ethernet brain has firmware version 5.0 or newer, or if you have a SNAP Simple I/O brain, use the steps in this section to change an IP address. For SNAP Ultimate and SNAP Ethernet brains with older firmware, see page 45.

NOTE: This method of changing the IP address uses FTP, which cannot get through a firewall in the PC where ioManager is running. Make sure any firewall in the computer (such as the built-in firewall in Windows XP) is disabled before you change the IP address. Firewalls in a router should not be a problem.

1. Choose Start > Programs > Opto 22 > ioProject Software > ioManager.

The ioManager main window opens:

2. Choose Tools > Change IP Settings.

The Change IP Settings window opens:
3. In the Current IP Address field, type the IP address of the device whose address you want to view or change. Click Read Current Settings to see the current subnet mask, gateway address, and DNS address.

4. If you want to change the IP address, subnet mask, or other addresses, enter the new numbers. Make sure you have typed everything correctly. When everything is correct, click Change IP Settings.

After you confirm the change, a message appears stating that the change was successful and that the device will restart. Restarting may take 10 to 20 seconds to complete. When you see the following indicator, the device is ready for use with its new address:

the brain’s STD LED blinks twice

Remember to write the IP address on the sticker on the device.

Brains with Older Firmware

To change the IP address of a brain with firmware older than version 5.0, follow these steps.

1. In the ioManager main window, click the Inspect button.
2. In the IP Address field, type the IP address of the I/O unit. Click Status Write.
3. In the Operation Command list, highlight Switch to Loader Mode.
4. Click Send Command.
   The brain goes into loader mode and can no longer be contacted through ioManager.

5. Connect the brain’s RS-232 port to the PC via serial cable, following the serial connection diagram below.

6. Close the ioManager Inspect window and return to the main window. From the Tools menu, choose Install Firmware via Serial Connection to open OptoFlash-ENET:
7. Make sure the correct COM port is shown. Choose Device > Serial Connection. The utility contacts the brain and displays its IP address, subnet mask, and other information:

![OptoFlash-ENET](image)

8. To change the IP address, subnet mask, or default gateway, type in the new numbers. Make sure they are correct. Then click Store All. The new data is sent to the brain.

9. Close the dialog box, OptoFlash-ENET, and ioManager. Turn off power to the brain and remove the serial cable.

10. Restore power to the brain. The brain is ready for use. If you changed the IP address, remember to write it on the label on the brain’s case.

**Viewing the IP Address**

If you don’t know the IP address of a SNAP Ethernet-based brain, follow these steps to find it out.
1. Turn off power to the brain. Remove the Ethernet connector.

2. Remove the SNAP Ethernet-based brain cover.
   The diagrams at right show the location of the jumpers, depending on the brain model.
   - For SNAP Ultimate and SNAP Ethernet brains, notice that jumpers go in sideways. Also notice that jumpers are oriented differently for standard brains and brains in a SNAP-IT-RM unit.
   - For SNAP Simple brains, jumpers are located on the board, below the serial port. You should be able to reach them without removing the board from its case.

3. Using needle-nosed pliers, remove the Boot to Kernel/Loader jumper.

4. Connect the brain’s RS-232 port to the PC via serial cable, following the serial connection diagram below.

5. Turn on power to the brain.

7. From the Tools menu, choose Install Firmware via Serial Connection to open OptoFlash-ENET:

8. Make sure the correct COM port is shown. Choose Device > Serial Connection. The utility contacts the brain and displays its IP address, subnet mask, and other information:
9. If you need to change the IP address, subnet mask, or default gateway, type in the new numbers. Make sure they are correct. Then click Store All. The new data is sent to the brain.

10. Close the dialog box, OptoFlash-ENET, and ioManager. Turn off power to the brain and remove the serial cable.

11. Put the jumper back in. Reinstall the brain cover.

12. Restore power to the brain.

The brain is ready for use. If you changed the IP address, remember to write it on the label on the brain’s case.

---

**Resetting a Brain to Factory Defaults**

If you need to reset a SNAP Ethernet-based brain to factory default settings, you can do so using an internal jumper. When you reset the brain, any files, strategy, archived strategy, and persistent variables in RAM and flash memory are erased. Engineering Units and counts go to zero. On a bipolar module, for example a -10 V to +10 V module, counts go to zero volts.

*NOTE: This operation completely resets the brain. If you only need to reset points to their defaults, see the instructions in the ioManager User’s Guide.*

*CAUTION: When you reset the brain to factory defaults, the IP address is reset to 0.0.0.0 and the subnet mask to 255.255.255.0. Before turning on the brain again, assign the correct IP address and subnet mask. See the ioManager User’s Guide for instructions.*

To reset the brain to factory defaults, follow these steps:
1. Turn off power to the brain. Remove the Ethernet connector.
2. Remove the SNAP Ethernet-based brain cover.
   The diagrams at right show the location of the jumpers, depending on the brain model.
   The diagrams show the brain as it comes from the factory and should be for normal operation.
   - For SNAP Ultimate and SNAP Ethernet brains, notice that jumpers go in sideways. Also notice that
     jumpers are oriented differently for standard brains and brains in a SNAP-IT-RM unit.
   - For SNAP Simple brains, jumpers are located on the board, below the serial port.
     You should be able to reach them without removing the board from its case.
3. Using needle-nosed pliers, remove the Boot to Kernel/Loader jumper and put the Reset to Factory Defaults jumper in. Turn on power to the brain.
4. Watch the STD LED (shown in the graphic above). Wait until the solid light goes off, and then turn off power to the brain.
   For more information on LEDs and blink codes, see page 63.
5. Remove the Reset to Factory Defaults jumper and insert the Boot to Kernel/Loader jumper, so the jumpers look like the figure again.
6. Reinstall the brain cover.
   The brain has now been reset to factory defaults. To assign a new IP address, follow the steps in the ioManager User’s Guide. When you restore power to the brain, it begins sending BootP requests immediately.

**Loading New Firmware**

Each SNAP Ethernet-based brain and each SNAP serial communication module contains firmware (sometimes called the kernel), which is similar to an operating system. If the firmware should become damaged, or if a new version of the firmware is released, you can use using ioManager to load new firmware to the device.

*NOTE: To load new firmware to a SNAP serial communication module, see Opto 22 form 1440, the ioManager User’s Guide, for instructions.*
Updating serial communication module firmware requires brain firmware 5.0 or higher. To update brain firmware from a version lower than 5.0, see page 54. Once the brain has firmware 5.0 or higher, you can then update the serial communication module firmware.

### Loading SNAP Ultimate Brain Firmware

These instructions apply to SNAP Ultimate brains that already have firmware version 5.0 or newer. If your SNAP Ultimate brain has firmware older than version 5.0, or if you have a SNAP Ethernet or SNAP Simple I/O brain, see the section "Loading Brain Firmware (All Other Brains)" on page 54.

1. Make sure you have the following before beginning:
   - New firmware from our Web site at www.opto22.com. If you have any difficulty obtaining or loading new firmware, contact Opto 22 Product Support.
   - IP address(es) of the brain(s) that will receive the new firmware.
2. Choose Start→Programs→Opto 22→IoProject Software→IoManager.
   
   The ioManager main window opens:

3. Click the Maintenance button.

   ![ioManager main window]

---

**Legacy SNAP Ethernet-Based I/O Units User's Guide**

52
4. Make sure Install Firmware is highlighted in the Command list.

5. Click the browse button and locate the firmware file you downloaded from our Web site. Double-click the filename.
   SNAP Ultimate brain firmware files have a file extension of .uio.
   The path and filename appear in the Filename field.

6. If the IP address(es) of the SNAP devices you want to load firmware to appear in the IP Addresses list, skip to step 8. (Or, if you have previously saved a list of IP addresses, click Load to load the saved list.) If the address(es) you need don’t appear in the list, click Add.

7. Enter the address or a range of consecutive addresses, then click OK. (Or, if you are communicating with the device using its host name instead of its IP address, click Host Name and enter the name.) The address(es) you entered appear in the I/O Unit Maintenance dialog box.
8. In the I/O Unit Maintenance dialog box, highlight the IP addresses to send firmware to.

CAUTION: If you enter the wrong IP address, you will erase the current firmware in that device. You cannot undo the erase. Make certain you have the correct IP addresses and that you want to download new firmware.

9. If you have changed the OptoMMP port, enter the correct port number. You can also change the number of seconds ioManager will wait before verifying that devices have restarted.

10. When everything is correct, click Execute.

The file is loaded to the SNAP devices, and progress is shown in the Results area. When the file is loaded and the devices are restarted, a “Success” message appears.

NOTE: If the download fails on a controller and you have FTP’d files to the controller’s file system, there might not be enough file space for the new firmware. To check, choose Start > Programs > Opto 22 > Project Software > Tools > Terminal. Make sure the File Space Available is larger than the size of the firmware file.

Loading Brain Firmware (All Other Brains)

If you are using a SNAP Ethernet or SNAP Simple I/O brain, or if your SNAP Ultimate brain contains firmware older than version 5.0, follow these steps to load new firmware.
1. Make sure you have the following before beginning:
   – New firmware from our Web site at www.opto22.com. If you have any difficulty obtaining or loading new firmware, contact Opto 22 Product Support.
   – IP address(es) of the brain(s) that will receive the new firmware.

2. Choose Start > Programs > Opto 22 > IO Project Software > ioManager.
   The ioManager main window opens:

3. Click the Inspect button.

4. In the IP Address field, type the IP address of the I/O unit. Click Status Write.

5. In the Operation Command list, highlight Switch to Loader Mode.
6. Click Send Command.
   The brain goes into loader mode and can no longer be contacted through ioManager.

7. Connect the brain’s RS-232 port to the PC via serial cable, following the serial connection
   diagram below.

8. Close the ioManager Inspect window and return to the main window. From the Tools menu,
   choose Install Firmware via Serial Connection to open OptoFlash-ENET:
9. Make sure the correct COM port is shown.

10. In the File to load field, type the location of the firmware file or click the browse button \( \ldots \) to locate it.
    - SNAP Ultimate brain firmware files have a file extension of .uio.
    - SNAP Ethernet brain firmware files have a file extension of .eio.
    - SNAP Simple I/O brain firmware files have a file extension of .sio.

11. When the firmware file appears in the field, click Load File.
    The firmware is loaded to the brain. The Status box shows its progress.

12. When the firmware is completely loaded, close OptoFlash-ENET. Turn off power to the brain and remove the serial cable.

13. Restore power to the brain.
    The I/O unit is ready to use.
If you are having difficulty using SNAP Ethernet-based I/O units, here are some suggestions that may help. If you cannot find the answers you need in this book, contact Opto 22 Product Support. Contact information is on page 5.

Communicating with the I/O Unit

If you attempt to connect to the I/O unit using its IP address and you cannot, first check the following:

- Make sure the I/O unit has been turned on and the RUN or PWR LED is lit. (See “LED Descriptions” on page 35.)
- Make sure the brain is mounted on the correct rack (see the table on page 72).
- Make sure the brain’s hold-down screw has been tightened so that it is firmly attached to the rack.
- Verify that you typed in the correct address for the I/O unit. Check the label on the side of the brain, where the IP address should be written.
- Make sure the I/O unit has been assigned a valid IP address and subnet mask. SNAP Ethernet-based brains come from the factory with a default IP address of 0.0.0.0, which is invalid. The default subnet mask is 255.255.255.0. To assign IP address and subnet mask, see the ioManager User's Guide.
- Make sure that no red LEDs on the brain are lit. A red LED could indicate a voltage supply problem. Each I/O unit should have its own power supply. The brain needs a minimum of 5.0 VDC, measured at the rack.
- Make sure you have up-to-date drivers installed on your computer’s Network Interface Card (NIC). Contact your system administrator or the manufacturer of the card for help.
- Make sure you have Administrator privileges on your computer and that any firewall in the computer (such as the built-in firewall in Windows XP) is temporarily disabled before you try to assign or change IP addresses, load firmware using ioManager’s Maintenance window, or work with files on the brain or controller. BootP and FTP cannot function through a firewall in the PC. Firewalls in a router are less likely to be a problem unless certain ports (such as FTP client) have been blocked, either by default or on purpose.
Pinging the I/O Unit

If you still cannot communicate with the I/O unit after you have checked these items, try to reach it using the PING protocol.

1. Choose Start → Programs and open a command prompt.
2. At the prompt, type: ping [I/O unit’s IP address]
   For example, type: ping 10.192.54.40

If the I/O unit responds, go to “Accessing the I/O Unit with ioManager” on page 60.

If the PING command cannot be found, choose Start → Control Panel → Network. Make sure TCP/IP is configured as a protocol and that an IP address and subnet mask are assigned.

If you see the message “Destination host route not defined,” the I/O unit probably has an inappropriate IP address and subnet mask. Make sure the IP address and subnet mask on the I/O unit are compatible with those on the computer. Follow the directions beginning on page 47 to check the IP address and subnet mask on the I/O unit, and change them if necessary.

If you see the message “No response from host,” check the following:

• Are the computer and I/O unit correctly connected? Is the I/O unit turned on?
• Are the IP address and subnet mask on the I/O unit compatible with those on the computer?
• Is the I/O unit in reset mode? (Check for a blinking STD light. STD blink codes are shown on page 63.)

If you still cannot ping the I/O unit, contact Opto 22 Product Support. (See page 5.)

Accessing the I/O Unit with ioManager

Once you know you can ping the I/O unit, try to access it using ioManager. You will need to know the I/O unit’s IP address.

1. If ioManager is not already open, choose Start → Programs → Opto 22 ioProject Software → ioManager.
   The ioManager main window opens:
2. In the ioManager main window, click the Inspect button.

3. In the IP Address field, type the IP address of the I/O unit (or choose it from the drop-down list). Click Status Read.

Information from the I/O unit is displayed in the window:

If information does not appear, contact Product Support. (See page 5.)
Solving Network Problems

If problems in communicating with the SNAP Ethernet-based I/O unit recur, check your network. The wires, switches, and so on in your Ethernet network are not part of the Opto 22 hardware, but any problems in your network may affect communication with Opto 22 products.

Create a Network Diagram

First, create a network diagram and verify the following:

- Cable connectors are firmly inserted.
- The switch has power. Switch LEDs indicate that the connection is up.
- Neither the PC nor the Ethernet-based I/O units use the switch’s uplink port.
- The brain’s 10MB or 100MB LED is lit.

Check Ethernet Errors

Next, use ioManager to check Ethernet errors reported by the I/O unit. These errors indicate network problems. You will need to know the I/O unit’s IP address.

1. Choose Start > Programs > Opto 22 > ioProject Software > ioManager.

2. In the ioManager main window, click the Inspect icon.

3. In the IP Address field, type the IP address of the I/O unit. Click Status Read.

4. Scroll down until you see the items Ethernet Errors: Late Collisions, Ethernet Errors: Excessive Collisions, and Ethernet Errors: Others.
Analyze Communication Packets

If it appears that you have network problems, you can use a network sniffer utility, such as Wireshark (http://www.wireshark.org/) to log and analyze network communication packets.

Have Your Network Certified

If you suspect network problems, you may need to have your network professionally certified. Opto 22 does not offer network validation or certification services, but many network hardware manufacturers do. Contact the manufacturer of your Ethernet network hardware to have them diagnose, fix, and certify your network.

If you continue to have problems communicating with the SNAP Ethernet-based brain after your network is certified, contact Opto 22 Product Support. (See page 5.)

Additional Troubleshooting Tools

Blink Codes for SNAP Ethernet-Based Brains

LEDs are described on page 35. The STD LED on most Ethernet-based brains, or the FLT LED on SNAP Simple brains, indicates conditions by blinking in specific patterns. The following table shows blink codes, what they mean, and how to work around any problems. To contact Product Support, see page 5.

<table>
<thead>
<tr>
<th>Number of Blinks</th>
<th>Speed of Blinks</th>
<th>Means</th>
<th>Problem and Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>slow</td>
<td>Firmware has started running.</td>
<td>No problems; brain is functioning normally.</td>
</tr>
<tr>
<td>3</td>
<td>slow</td>
<td>Firmware CRC check failed; brain has jumped to loader.</td>
<td>No valid firmware in flash; download new firmware via serial port.</td>
</tr>
<tr>
<td>4</td>
<td>slow</td>
<td>Loader info area has a bad CRC.</td>
<td>Loader information stored in VRAM is corrupt. Indicates a hardware problem; call Product Support.</td>
</tr>
<tr>
<td>5</td>
<td>slow</td>
<td>Fatal error</td>
<td>Firmware or hardware problem. Make sure the hold-down screw on the top of the brain is tightened and check the power supply; call Product Support.</td>
</tr>
<tr>
<td>6</td>
<td>slow</td>
<td>BootP was successful.</td>
<td>Not a problem; IP address has been successfully assigned.</td>
</tr>
<tr>
<td>7</td>
<td>slow</td>
<td>Flash programming failure</td>
<td>Flash chips failed to erase properly or program properly; call Product Support.</td>
</tr>
<tr>
<td>10</td>
<td>slow</td>
<td>RAM error</td>
<td>Contact Product Support.</td>
</tr>
<tr>
<td>11</td>
<td>slow</td>
<td>Internal error</td>
<td>Contact Product Support.</td>
</tr>
<tr>
<td>13*</td>
<td>slow</td>
<td>Loader problem</td>
<td>Try turning off power to the brain and turning it back on again. If blinks still occur, call Product Support.</td>
</tr>
</tbody>
</table>
Determining Whether the I/O Unit is in Loader Mode

A SNAP Ethernet-based I/O unit can start up (boot) in one of two modes: kernel (firmware) or loader. Normal operation is to boot in kernel mode, meaning that the I/O unit boots to its firmware. For some operations, however (such as downloading new firmware), the I/O unit boots to loader mode, meaning that it starts up without firmware.

Kernel/loader mode can be changed using an internal jumper inside the brain’s case.

If you are having trouble communicating with the I/O unit and suspect it might be in loader mode, do one of the following to find out:

- Turn off power to the I/O unit, then turn it back on. Watch the STD LED. Three slow blinks means the I/O unit is in loader mode.
- Turn off power to the I/O unit, remove the brain’s top cover, and look at the Boot to Kernel/Loader jumper. See diagram on page 47. If the jumper is removed, the I/O unit is in loader mode.
- Try to ping the I/O unit. See steps on page 60. If the I/O unit is in loader mode, it will not respond. (There may be other reasons it does not respond, however; see the notes in “Pinging the I/O Unit.”)

If the I/O unit is in loader mode, replace the jumper if it was removed (see page 47 for diagram). If the I/O unit remains in loader mode, load new firmware (page 51).

TCP Settings

Retransmit timeout (RTO) refers to the length of time the I/O unit waits while communicating before timing out. The RTO is determined by the brain’s TCP/IP stack, and the stack continually recalculates the RTO based on recent network traffic. If the network becomes busier, for example, the stack automatically adjusts the RTO to a higher value.

If the TCP/IP stack times out while trying to transmit data, it doubles the current RTO and tries again. This process continues for five retries; after that, the SNAP brain stops trying and sends a timeout message.

If you are receiving frequent timeout messages from the I/O unit, you can change the TCP parameters in ioManager.

1. Choose Start > Programs > Opto 22 > Project Software > ioManager.

<table>
<thead>
<tr>
<th>Number of Blinks</th>
<th>Speed of Blinks</th>
<th>Means</th>
<th>Problem and Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>14*</td>
<td>slow</td>
<td>Brain was reset to factory defaults.</td>
<td>Not a problem. Brain has been reset to factory defaults. IP address is now 0.0.0.0, so assign a new IP address. See the ioManager User’s Guide for instructions.</td>
</tr>
<tr>
<td>15</td>
<td>fast</td>
<td>IP address was cleared.</td>
<td>Not a problem. IP address is now 0.0.0.0. Assign a new IP address. See the ioManager User’s Guide for instructions.</td>
</tr>
</tbody>
</table>

* Does not apply to SNAP Ethernet brains.
2. In the ioManager main window, click the Inspect icon.
3. In the IP Address field, type the IP address of the SNAP I/O unit. Click Status Write.

![Inspect Opto 22 Device](image)

CAUTION: Note the following recommended settings:

- **TCP Minimum Retransmission Timeout (msec):** 250
- **TCP Initial Retransmission Timeout (msec):** 3000
- **TCP Retransmission Attempts:** 5
- **TCP Idle Session Timeout (msec):** 240,000

If you set these fields too low, you may not be able to communicate with the device at all, even through ioManager, to fix the settings. Then you would have to reset the I/O unit to factory defaults (see page 50).

4. Change these four fields as necessary:
   - **Minimum RTO** sets an absolute minimum value for the RTO. The device's calculated RTO will never go below this value.
   - **Initial RTO** sets the RTO for the first communication try. Be careful: since all future tries are based on this value, if you set it too low for network conditions, a connection will never be made.
   - **TCP Retransmits** sets the number of times the device retries communication. Larger, busier networks need a higher number of retransmits than smaller networks with less traffic.
TCP idle session timeout sets how long (in milliseconds) the device allows a session to remain open without any activity. After this time, the device checks the session to make sure it is still good, and closes it if it is not. The default is 240,000 milliseconds, or four minutes.

5. Click the Apply button to write your changes to the SNAP I/O unit.
6. In the Operation Commands list, highlight Store configuration to flash. Click Send Command.
7. In the Operation Commands list, highlight Restart brain from powerup. Click Send Command. The new TCP parameters are set.

Getting Device and Firmware Information

If you need to contact Opto 22 Product Support for assistance in using an I/O unit, it is helpful to have device and firmware information at hand before you call us.

1. Choose Start Programs Opto 22 ioProject Software ioManager.
2. In the ioManager main window, click the Inspect button.
3. In the IP Address field, type the IP address of the device. Click Status Read.

The example shows a SNAP Ethernet I/O unit; other I/O units are similar.
SNAP Digital Troubleshooting

Q: I have a SNAP digital module that has ceased to function. What may have caused this?

A: Loss of function in a SNAP digital module is normally caused by misapplication. As with Opto 22’s other digital I/O module families, there is no one way in which SNAP I/O modules fail. Output modules normally fail in a different way than inputs.

Output modules usually fail open, or half-wave for AC, and the failure is normally caused by the application of too much current or by degradation of the semiconductor switch by overvoltage.

Because the module is separated into two parts by the optical isolator, it is possible to have an output module that behaves properly on the logic side but is broken on the field side. The LED will in most cases continue to turn on and off as commanded by the driving logic device, even though the module has failed.

The first step to troubleshooting a failed module is to check the fuse. If it is blown, simply replacing it should get the module working again. If the module continues to blow fuses, analyze the load to see if the module is really suitable to the application.

When input modules fail, they usually do so on the field side, typically from overvoltage or overcurrent resulting from overvoltage. Opto 22’s SNAP AC and DC input modules contain a full-wave rectifier (as opposed to the G1 and G4 modules, which contain a bridge rectifier), allowing hookup without regard to polarity. Unlike output modules, an input module’s LED normally will not function as expected when the module has failed.

Failures on the field side of all types of Opto 22 digital I/O modules occur extremely rarely and are typically the result of misapplication. The logic-side failures of Opto 22’s I/O modules are also extremely rare. Usually, a failure of the logic side is attributable to using the module at the wrong logic voltage or to miswiring.

Q: I have an input module that seems to “flicker” when a voltage is applied to it. What is happening here?

A: Opto 22’s basic input modules contain full-wave rectifiers. In an AC application it is possible to destroy one-half of the rectifier and still have the module function after a fashion. The full-wave rectifier turns into a half-wave rectifier, causing the module to turn on and off at the line frequency when an input is applied. This may be seen visibly as “flicker” on the channel status LED.

Digital logic devices, having much faster detection times than the human eye, can have serious problems with this failure mode. For example, a digital counter attached to a failed module will count at the input frequency.

This failure occurs most commonly in applications where the input module is placed in parallel with an inductive load. When the load turns off, the back-EMF goes right through the module, destroying one-half of the bridge.

Placing a transorb or large R-C snubber in parallel with both the load and input module will significantly reduce the frequency of, or eliminate entirely, this type of failure.
Q: I have an output module driving a load. The load turns on okay but never seems to turn off, unless I remove power from the relay entirely. What might be happening?

A: This problem may occur when using an output module with a high-impedance load, such as a neon lamp or a small solenoid. Loads like these often have relatively large initial currents but relatively small “hold-in” currents. The result is that the off-state leakage current through the module is insufficient to cause the load to turn on to start with, but sufficient to keep it on once started.

The solution to this problem is to place a power resistor, sized for 8–10 times the rated maximum leakage current for the module, in parallel with the load. Make sure that this resistor has a high enough power rating for the application.

Q: I have a new AC output driving a solenoid. It turns on okay once, but will not turn on again. What is going on?

A: Some solenoids and some types of halogen lights incorporate a diode in series with the coil or filament. This causes the light to behave as a half-wave rectifier. Opto 22 output modules have a built-in R-C snubber circuit in parallel with the output. The capacitor in this circuit charges up but cannot discharge through the series diode, causing a voltage to appear across the output terminals. Because the module must see a zero voltage across the terminals to come on, it can’t turn on again in this situation.

The solution is to find a lamp or solenoid that does not have an internal diode; a potential work-around would be to put a high-value resistor (several tens of KOhms) across the output terminals of the module, to allow the capacitor to drain its charge.

Q: I have an AC output module in a circuit, wired in series (ANDed) with another contact. When that other contact closes, my load turns on momentarily, even though my output module is off. Is my module broken?

A: This situation arises when the output module does not see a voltage across its terminals. This occurs when another contact is wired in series with the module, between the module and the “hot” side of the supply. Because the module is totally isolated from field to logic, the field (or contact) side of the module must power itself from the attached line. By nature of the pilot circuit in the module, the switching semiconductor is in an indeterminate state when there is no voltage across the module. It may turn on for up to a half cycle if it is suddenly “wet.” The pilot circuit will realize that the module is on, but it cannot turn it off until the voltage crosses zero again.

There is no easy solution to this problem. Typically a solution will involve either maintaining a minimal voltage across the module, pre-wetting it with a low voltage, or absorbing the energy from the half-cycle turn-on with an R-C network in parallel with the load.

Q: Why are all four loads connected to my SNAP output module coming on when I’m activating only one of the channels?

A: The SNAP digital output is likely connected on the wrong side of the loads. Remember that all four channels share one fuse; thus one side of each output is common with one side of all the others. If the module is on the wrong side of the load, any one channel is effectively connected to all four. If the output is a SNK type, try switching to a SRC type. In AC applications, reverse the module wiring.
Q: I keep having failures on one channel of my SNAP output module. Why might this be happening?

A: Failures of only one of the four output channels would indicate a problem with the load being driven by that channel. Make sure that the load characteristics, including transient characteristics, do not exceed the capabilities of the module. Also be sure that the module is properly transient protected, using either an R-C snubber (AC) or a commutating diode (DC) across the load. Modules may also be protected through the use of transient voltage suppressors across the module itself.

**SNAP Analog Troubleshooting**

SNAP analog modules require a fairly substantial amount of current due to their on-board isolation power inverters. Because of this, it is important to make certain that the entire SNAP installation is supplied with 5.0 to 5.2 V, even while under full load.

See Opto 22 form #1403, SNAP I/O Wiring Guide, for help in determining the full load required for an I/O unit, which includes the brain or on-the-rack controller and all modules. Insufficient power supply could cause symptoms ranging from module “drift” to random resets and communication problems on the brain. The SNAP equipment is designed with a fail-safe voltage watchdog feature that inhibits operation when power supply voltage levels get too low, thus eliminating the possibility of unintentional output or input. Opto 22 offers DIN-rail-mountable power supplies for use with SNAP I/O systems.

Keep in mind that unless you purchase an isolated module, the channels on a SNAP input or output module are not isolated from one another. Make certain that any transducers or equipment that these modules are used with are floating, isolated from local earth ground. If the equipment is not floating, make certain that the two pieces of equipment being connected are at the same ground potential in order to eliminate the possibility of a ground loop through the module. A ground loop through the module could result in almost anything, from inaccurate readings to catastrophic failure of the module.

SNAP analog modules, like any high-level electronics, require protection from electrical noise in high-noise environments, such as installations near arc or plasma equipment or AC inverters. If the SNAP analog system is to be installed in such an environment, be certain that the system is enclosed in an appropriate enclosure. Opto 22 has several documents available that discuss grounding and shielding practice, noise mitigation, and electromagnetic compatibility:

- Grounding, Shielding, Noise, and Compatibility (Opto 22 form #TN9603)
- Grounding and Wiring Practices (form #TN9603A)
- Operational Interferences and Noise (form #TN9603B)
- Interference Generation and Compatibility (form #TN9603C)
Introduction

This appendix includes wiring diagram examples for assembling your Ethernet-based I/O system and attaching it to the devices it will monitor and control. The system includes the Ethernet-based processor (brain or rack-mounted controller) and SNAP I/O modules mounted on a SNAP rack, powered by a SNAP power supply.

Example: SNAP Ethernet I/O system, partly assembled.

This document includes basic wiring information for SNAP racks, power supplies, processors (brains or rack-mounted controllers), and I/O modules. For more information, see the data sheet and the installation or user’s guide for your specific products.
SNAP Mounting Racks

SNAP mounting racks can hold a SNAP processor (brain or rack-mounted controller) and up to 4, 8, 12, or 16 SNAP modules.

The following table shows SNAP rack and processor compatibility. “Processor” refers to a brain or a rack-mounted controller. “Mixed” means that a rack can hold both analog and 4-channel digital modules, plus serial and high-density digital modules (digital modules with more than 4 points) if the processor supports them.

<table>
<thead>
<tr>
<th>Processor Part Number</th>
<th>Compatible Racks</th>
<th>Rack Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNAPP-UP1-M64</td>
<td>SNAP-M16</td>
<td>4-module mixed (digital functions depend on processor; 4-channel and high-density digital modules OK)</td>
</tr>
<tr>
<td>SNAP-ENET-S64</td>
<td>SNAP-M32</td>
<td>8-module mixed (digital functions depend on processor; 4-channel and high-density digital modules OK)</td>
</tr>
<tr>
<td></td>
<td>SNAP-M48</td>
<td>12-module mixed (digital functions depend on processor; 4-channel and high-density digital modules OK)</td>
</tr>
<tr>
<td></td>
<td>SNAP-M64</td>
<td>16-module mixed (digital functions depend on processor; 4-channel and high-density digital modules OK)</td>
</tr>
<tr>
<td>SNAPP-UP1-ADS</td>
<td>SNAP-B4M</td>
<td>4-module mixed</td>
</tr>
<tr>
<td>SNAP-B3000-ENET</td>
<td>SNAP-B8M</td>
<td>8-module mixed</td>
</tr>
<tr>
<td>SNAP-ENET-RTC</td>
<td>SNAP-B8MC</td>
<td>8-module mixed, terminal block</td>
</tr>
<tr>
<td></td>
<td>SNAP-B8MC-P</td>
<td>8-module mixed, pluggable terminal block</td>
</tr>
<tr>
<td></td>
<td>SNAP-B12M</td>
<td>12-module mixed (4-channel digital in positions 0–7 only)</td>
</tr>
<tr>
<td></td>
<td>SNAP-B12MC</td>
<td>12-module mixed (4-channel digital in positions 0–7 only), terminal block</td>
</tr>
<tr>
<td></td>
<td>SNAP-B12MC-P</td>
<td>12-module mixed (4-channel digital in positions 0–7 only), pluggable terminal block</td>
</tr>
<tr>
<td></td>
<td>SNAP-B16M</td>
<td>16-module mixed (4-channel digital in positions 0–7 only)</td>
</tr>
<tr>
<td></td>
<td>SNAP-B16MC</td>
<td>16-module mixed (4-channel digital in positions 0–7 only), terminal block</td>
</tr>
<tr>
<td></td>
<td>SNAP-B16MC-P</td>
<td>16-module mixed (4-channel digital in positions 0–7 only), pluggable terminal block</td>
</tr>
<tr>
<td></td>
<td>SNAP-D64RS</td>
<td>16-module digital only (limited digital functions; 4-channel digital modules only)</td>
</tr>
</tbody>
</table>
Racks Without Terminal Strips

SNAP racks come either with or without a common terminal strip. The following diagram shows a rack without a terminal strip. For this type of rack, all wiring connections are made to the field connectors on the top of each module. A processor is shown on this rack, but the modules have not been inserted yet.

Racks with Terminal Strips

If your rack has a terminal strip, you can use it for field wiring common connections, such as loop power distribution, or low-current applications. The following diagram shows a rack with a terminal strip (MC rack models); the smaller diagram shows the optional terminal strip with pluggable connectors (MC-P rack models). Terminal strips do not connect to SNAP modules; depending on your application, you may need to install wiring from the terminal strip to the module. (Again, the rack is shown with a processor but with no modules.)
SNAP Power Supplies

Primary Power Supply

NOTE: For a more general discussion of using power supplies with Opto 22 systems, see Opto 22 form #1271, a technical note available on our website at www.opto22.com.

SNAP racks use a 5 VDC power source (5 VDC [-0.0, +0.1] at minimum 4.0 Amps recommended). For systems using AC source voltage, the SNAP-PS5 or SNAP-PS5U power supply is recommended. For DC systems, such as those using DC backup power, the SNAP-PS5-24DC offers DC-to-DC power.

In general, we recommend you use an independent, isolated, regulated power supply locally with each rack. Local isolated supplies offer these advantages:

- Short supply conductors, which minimize losses
- Power redundancy, so the failure of a single supply causes only a single rack failure, not a total system failure
- Fewer voltage drops and ground loops. (Voltage drops and subsequent ground loops may occur when power is distributed over a large system.)

Always use a separate power supply for the field side of the I/O. Using the rack supply for field actuation and monitoring defeats the isolation the I/O module offers and therefore increases the chance of a ground loop within the control system. Additionally, a sudden change of current on the field side can cause undesirable voltage fluctuations that may interfere with the computer’s operation.

Determining Power Requirements

Both the SNAP-PS5 and the SNAP-PS5-24DC power supplies provide 5 VDC power for loads up to 4 Amps. The SNAP-PS5U provides 5 VDC for loads up to 5 Amps. In most cases this power is sufficient
for a SNAP processor, a rack, and the associated I/O modules. However, some combinations of modules, especially special-purpose modules, may require additional power. You can use the following tables to help determine power needs for your I/O units.

**Processor Power Requirements**

<table>
<thead>
<tr>
<th>Processor (Brain or Rack-mounted Controller)</th>
<th>Power Req. (Amps)*</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNAP Ultimate controller/brains (all models)</td>
<td>1.000</td>
</tr>
<tr>
<td>SNAP Ethernet brains</td>
<td>0.800</td>
</tr>
<tr>
<td>SNAP Simple I/O brains</td>
<td>0.500</td>
</tr>
</tbody>
</table>

*Current from 5-volt supply

**I/O Unit (Processor, Rack, and I/O Modules) Power Requirements Worksheet**

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>X Power Req. (Amps)</th>
<th>Total Power Required (Amps)¹</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNAP processor (Enter Amps from Processor Power Requirements table)</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-IDC5-SW digital input module</td>
<td></td>
<td>0.200</td>
<td></td>
</tr>
<tr>
<td>SNAP-IDC5-SW-NC digital input module</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Isolated analog input and output modules (part numbers ending in -i or iSRC)</td>
<td></td>
<td>0.050</td>
<td></td>
</tr>
<tr>
<td>All other 4-channel digital input and output modules (not high-density digital modules)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-AICTD and SNAP-AICTD-4 analog input modules</td>
<td></td>
<td>0.150</td>
<td></td>
</tr>
<tr>
<td>SNAP-IDC-32, SNAP-ODC-32-SNK, &amp; SNAP-ODC-32-SRC high-density digital input and output modules All analog output modules except SNAP-AOA-iSRC</td>
<td></td>
<td>0.170</td>
<td></td>
</tr>
<tr>
<td>SNAP-AIARMS analog input module</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-AIVRMS analog input module</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-AIMA and AIMA-4 analog input modules</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-AITM and AITM-2 analog input modules</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-AIMV-4 and AIMV2-4 analog input modules</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-AIV and AIV-4 analog input modules</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-AIRTD analog input module</td>
<td></td>
<td>0.190</td>
<td></td>
</tr>
<tr>
<td>SNAP-AIR40K-4 analog input module</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-AIRATE analog input module</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNAP-AIPM power monitoring module</td>
<td></td>
<td>0.100</td>
<td></td>
</tr>
<tr>
<td>SNAP-AILC load cell module</td>
<td></td>
<td>0.120</td>
<td></td>
</tr>
<tr>
<td>Serial communication and Profibus modules</td>
<td></td>
<td>0.250</td>
<td></td>
</tr>
</tbody>
</table>

**Total**

1 Current from 5-volt supply
2 Can be used with SNAP Simple and SNAP Ultimate

**IMPORTANT:** For a SNAP-PS5 or a SNAP-PS5-24DC power supply, the total power required must not exceed 4 Amps. For a SNAP-PS5U, the total power required must not exceed 5 Amps.
Wiring the Primary Power Supply

Use one power supply per I/O unit. Use 14 AWG wire.

1. Mount the SNAP-PS5 or SNAP-PS5-24DC power supply so that the attached red and black power wires will reach the + and – power terminals on the SNAP mounting rack.

2. Using the power terminals on the SNAP mounting rack, attach the red wire to the + terminal and the black wire to the – terminal. Connect the ground terminal on the SNAP rack to ground.

3. For the SNAP-PS5 (not illustrated): Using the removable input power connector on top of the power supply, apply 120 volts AC power between the two terminals marked “AC.” Connect the ground terminal to ground.

4. For the SNAP-PSSU (not illustrated): Using the removable input power connector on top of the power supply, apply 240 or 120 volts AC power between the two terminals marked “AC.” Connect the ground terminal to ground.

5. For the SNAP-PS5-24DC (illustrated below): Using the removable input power connector on top of the power supply, apply 24 volts DC power between the two terminals marked “±DC.” Connect the ground terminal to ground.
Loop Power Supply

Some analog modules (SNAP-AIMA, SNAP-AIMA-4, SNAP-AIMA-i, SNAP-AIMA2-i) also require a current loop supply, which can be provided by the SNAP-PS24 or the SNAP-PS24U. Both offer 24 volts of DC power, the SNAP-PS24 at .75 A and the SNAP-PS24U at 1.25 A. Follow these steps to wire these power supplies.

1. Mount the SNAP-PS24 or SNAP-PS24U power supply in a location where the attached output power wires will reach the field connector for SNAP analog modules.

   The white and red wire is the positive wire (24 VDC). The white and black wire is the negative wire (24 VDC return).

2. If you are wiring directly to the module, see the wiring diagram for the specific module you are using.

   Examples for an input module are shown in the following diagrams.

SNAP-PS24

In this diagram, the SNAP-PS24 power supply supplies power directly to the input module. The SNAP-PS5 supplies power to the rack.

SNAP-PS24U

Here, the SNAP-PS24U power supply supplies power directly to the input module. The SNAP-PS5U supplies power to the rack.
3. If you are wiring to a rack with a field wiring terminal strip (models MC and MC-P), see Opto 22 form 784 for specific loop power wiring information. Examples are shown in the following diagrams:

**SNAP-PS24**

In this diagram, the SNAP-PS24 power supply supplies power directly to the input module. The SNAP-PS5 supplies power to the rack.

**SNAP-PS24U**

Here, the SNAP-PS24U power supply supplies power directly to the input module. The SNAP-PS5U supplies power to the rack.
4. Connect the ground terminal to ground. Using the removable input power connector on top of the power supply, apply 120 volts of AC power between the two terminals marked AC.

**SNAP Processors**

Refer to "SNAP Mounting Racks" on page 72. Make certain you have a compatible processor and rack before you begin.

1. Assemble the rack, power supply, and modules according to the directions that came with them.

   **CAUTION:** Make certain that you have the correct SNAP rack for the processor (brain or rack-mounted controller) you are using. Using the wrong rack will severely damage the processor.

2. Remove the processor from its packaging.
3. Turn off power to the rack assembly.
4. Align the processor’s connector with the mating connector on the mounting rack, as shown in the diagram at right.
5. Seat the processor onto the connector and use the hold-down screw to secure it in position. Do not overtighten.
6. Using Category 5 or superior solid unshielded twisted-pair cable, connect the processor in one of the following ways:
   - (Recommended for initial configuration) Connect to a PC directly, using an Ethernet crossover cable.
   - Connect to a standard 10BASE-T or 100BASE-TX Ethernet network that has
a PC on the same subnet as the processor and does NOT have a Dynamic Host Configuration Protocol (DHCP) server.

Maximum cable or segment length is 100 meters; minimum cable length is one meter.

7. Follow instructions in the processor’s data sheet or user’s guide for communications wiring and jumper settings, if applicable.

SNAP I/O Modules

SNAP digital modules are either 4-channel or more than four channels (high density). SNAP analog modules range from one to eight channels.

SNAP Digital Applications

Q: What is the difference between the SRC and SNK digital DC output modules?

A: SRC and SNK stand for SouRCing and SiNKing, respectively. Because one fuse is used for all output channels on the module, Opto 22 designed two different varieties. The selection of the module type depends on which side of the load the module is placed on. Typically, a SRC module is used between the + terminal and the load, while a SNK module would be used between the load and the −, ground, or common terminal. Please note that if the wrong module is used in the wrong place, all channels will effectively become common and all loads will be activated if any one channel is turned on.

Q: Why is there only one digital AC output module, when there are two DC modules?

A: Only one AC module design is required, because the switching devices used in the AC module are non-polar, unlike the transistors used in the DC modules. So the AC module may be used for sourcing or sinking, as long as all channels on the module are wired in the same way.

Q: Is there any way to get more than 0.75 A current capacity out of each channel on the 4-channel digital output module?

A: Yes. SNAP 4-channel digital output modules are not rated on a channel-to-channel basis; instead, the entire module is rated for a maximum of 3 A. Any one channel on the module can carry up to 3 A, as long as the total current being carried by the module is 3 A or less. Thus, two of four channels can be used to carry 1.5 A each, with two channels unused.

Q: Can I wire the channels on a SNAP digital output module in parallel to obtain a higher current rating?

A: This question is related to the question above. There really isn’t a need to wire channels in parallel, because each channel can carry up to 3 A; just be certain that the total current passing through the module is 3 A or less. Wiring the channels in parallel will not make any difference as far as performance goes; one channel will likely activate before the others and thus take up the entire load itself anyway. Parallel wiring does allow for some automatic fallback redundancy in case one channel fails open, however.
Q: Is there a SNAP digital input module for DC voltages over 32 V?
A: Yes. SNAP AC input modules may be used for DC input up to their voltage rating. For example, a SNAP-IAC5 can be used to read 125 VDC input signals. Most SNAP input modules use a full-wave rectifier on the input, allowing the module to be used as an AC or DC input and making it resistant to reversed-polarity installations.

Q: Is there a way to read low-voltage AC signals with a SNAP input module?
A: Yes. In the same way that SNAP AC modules can be used for DC, some SNAP DC modules can be used to take low-voltage AC signals, such as the 24 VAC commonly used in HVAC systems. This is allowable with all SNAP DC modules containing a full-wave rectifier.

Q: Does Opto 22 make a SNAP digital input module for high-speed signals? Or for quadrature input use?
A: Yes to both questions, and we offer many other digital input modules as well. For a complete list, see the Opto 22 website.

Q: What sort of isolation is provided by Opto 22 SNAP digital modules?
A: SNAP digital modules are optically isolated against transient voltages to 4,000 Vrms between the field and logic connections. Input modules are isolated up to 300 VAC between each channel on the module. There is no isolation from channel to channel on most digital output modules, due to the common connection on each module for fusing purposes, but isolated output modules are available.

SNAP Analog Applications

Q: What types of SNAP analog modules are available?
A: The software-configurable SNAP analog modules handle a wide variety of signal types, including voltage, current, rate, temperature, RMS, and more. New modules are added frequently. See the Opto 22 website for models and specifications.

Q: What type of resolution do SNAP analog inputs provide?
A: SNAP analog input modules have a typical resolution of ±25,000 counts. This equates to roughly 14.5-bit resolution plus sign, or 15.5-bit full-scale resolution. These odd resolutions are a result of the inherent accuracy of the input amplifiers used to buffer the analog-to-digital converter from the signal source. While the analog-to-digital converter may be capable of providing higher resolution numbers, they are essentially useless because of the precision level of the signal conditioning circuitry and the amount of noise inherent in any electrical signal.

Q: What type of resolution do SNAP analog output modules achieve?
A: SNAP analog outputs are 12-bit resolution, yielding 4,095 counts from zero to full-scale.

Q: How much isolation do SNAP analog modules provide?
A: SNAP analog modules are transformer and optically isolated to 4,000 Vrms between the module and the rack/brain. Most SNAP analog modules are not isolated between channels; the channels share a common return connection. However, isolated analog modules are available.

Field Connector

Most SNAP input and output modules have a top-mounted, pluggable field connector for easy access when the module is installed on the SNAP mounting rack. The following diagrams show the field connector and the location of pin 1. (For modules with different wiring connectors, see the wiring diagrams for the specific module in the following pages.)

Module Wiring Diagrams

Module wiring diagrams begin on the following pages:

- 4-channel digital input modules  page 84
- 4-channel digital output modules  page 85
- High-density digital modules  page 89
- Analog input modules  page 92
- Analog output modules  page 102
Serial communication modules  page 104
PID modules  page 108
4-Channel Digital Input Modules

For high-density digital modules, see page 89.

Wiring for most 4-channel digital input modules (except SNAP-IDC5-SW and SNAP-IDC5-SW-NC).

**CAUTION:**
The SNAP-IDC5-SW and SNAP-IDC5-SW-NC inputs are not intended to be used with contacts that are connected to any external user-supplied voltage or currents.
4-Channel Digital Output Modules

For high-density digital modules, see page 89.


FIELD WIRING DC-SOURCING OUTPUT

FIELD TERMINAL POSITIONS 1, 3, 5, AND 7 ARE INTERNAL BUSSED CONNECTIONS.
COMMUTATING DIODE MUST BE USED ON INDUCTIVE LOADS. (TYPICAL INADS)

SNAP MODULE FIELD CONNECTOR

Wiring for SNAP-ODC5SNK, SNAP-ODC5ASNK, and SNAP-ODC5SNKFM [Obsolete] digital DC output modules.

FIELD WIRING DC-SINKING OUTPUT

FIELD TERMINAL POSITIONS 1, 3, 5, AND 7 ARE INTERNAL BUSSED CONNECTIONS.
COMMUTATING DIODE MUST BE USED ON INDUCTIVE LOADS. (TYPICAL INADS)
Wiring for SNAP-ODC5R, SNAP-ODC5R5, SNAP-ODC5RFM [Obsolete], and SNAP-ODC5R5FM [Obsolete] dry contact output modules.

Wiring for SNAP-ODC5MA digital DC output module with manual/auto switches.
High-density Digital Modules

Wiring for high-density digital connector used with both input and output modules.

For additional information, see form #1547, the SNAP High-density Digital Module User’s Guide.

<table>
<thead>
<tr>
<th>Harness Wire Color</th>
<th>Pin Number</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gray</td>
<td>40</td>
<td>A0</td>
</tr>
<tr>
<td>Blue</td>
<td>38</td>
<td>A1</td>
</tr>
<tr>
<td>Yellow</td>
<td>36</td>
<td>A2</td>
</tr>
<tr>
<td>Red</td>
<td>34</td>
<td>A3</td>
</tr>
<tr>
<td>Black</td>
<td>32</td>
<td>ACOM</td>
</tr>
<tr>
<td>Gray</td>
<td>30</td>
<td>B0</td>
</tr>
<tr>
<td>Blue</td>
<td>28</td>
<td>B1</td>
</tr>
<tr>
<td>Yellow</td>
<td>26</td>
<td>B2</td>
</tr>
<tr>
<td>Red</td>
<td>24</td>
<td>B3</td>
</tr>
<tr>
<td>Black</td>
<td>22</td>
<td>BCOM</td>
</tr>
<tr>
<td>Gray</td>
<td>20</td>
<td>C0</td>
</tr>
<tr>
<td>Blue</td>
<td>18</td>
<td>C1</td>
</tr>
<tr>
<td>Yellow</td>
<td>16</td>
<td>C2</td>
</tr>
<tr>
<td>Red</td>
<td>14</td>
<td>C3</td>
</tr>
<tr>
<td>Black</td>
<td>12</td>
<td>CCOM</td>
</tr>
<tr>
<td>Gray</td>
<td>10</td>
<td>D0</td>
</tr>
<tr>
<td>Blue</td>
<td>8</td>
<td>D1</td>
</tr>
<tr>
<td>Yellow</td>
<td>6</td>
<td>D2</td>
</tr>
<tr>
<td>Red</td>
<td>4</td>
<td>D3</td>
</tr>
<tr>
<td>Black</td>
<td>2</td>
<td>DCOM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signal</th>
<th>Pin Number</th>
<th>Harness Wire Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4</td>
<td>39</td>
<td>White</td>
</tr>
<tr>
<td>A5</td>
<td>37</td>
<td>Violet</td>
</tr>
<tr>
<td>A6</td>
<td>35</td>
<td>Green</td>
</tr>
<tr>
<td>A7</td>
<td>33</td>
<td>Orange</td>
</tr>
<tr>
<td>ACOM</td>
<td>31</td>
<td>Brown</td>
</tr>
<tr>
<td>B4</td>
<td>29</td>
<td>White</td>
</tr>
<tr>
<td>B5</td>
<td>27</td>
<td>Violet</td>
</tr>
<tr>
<td>B6</td>
<td>25</td>
<td>Green</td>
</tr>
<tr>
<td>B7</td>
<td>23</td>
<td>Orange</td>
</tr>
<tr>
<td>BCOM</td>
<td>21</td>
<td>Brown</td>
</tr>
<tr>
<td>C4</td>
<td>19</td>
<td>White</td>
</tr>
<tr>
<td>C5</td>
<td>17</td>
<td>Violet</td>
</tr>
<tr>
<td>C6</td>
<td>15</td>
<td>Green</td>
</tr>
<tr>
<td>C7</td>
<td>13</td>
<td>Orange</td>
</tr>
<tr>
<td>CCOM</td>
<td>11</td>
<td>Brown</td>
</tr>
<tr>
<td>D4</td>
<td>9</td>
<td>White</td>
</tr>
<tr>
<td>D5</td>
<td>7</td>
<td>Violet</td>
</tr>
<tr>
<td>D6</td>
<td>5</td>
<td>Green</td>
</tr>
<tr>
<td>D7</td>
<td>3</td>
<td>Orange</td>
</tr>
<tr>
<td>DCOM</td>
<td>1</td>
<td>Brown</td>
</tr>
</tbody>
</table>

Connector wiring for SNAP-IDC-32, SNAP-ODC-32-SRC, and SNAP-ODC-32-SNK high-density digital modules
Wiring for SNAP-IDC-32 high-density digital input.

Also see wiring for connector on page 89.

Also see wiring for connector on page 89.

**FUSING**

For both sourcing and sinking modules, use one of the two fusing options shown in the first two output groups below.

---

**SNAP-ODC-32-SRC**

Load Sourcing Module

**SNAP-ODC-32-SNK**

Load Sinking Module
Analog Input Modules

Wiring for SNAP-AIARMS analog amps RMS AC/DC input.

Two possible wiring diagrams are shown. Terminals 3, 4, 7, and 8 share a common connection inside the module. Make sure you observe polarity when connecting the second channel. To avoid a potentially hazardous short, double-check wiring before turning on the

Wiring for SNAP-AIARMS-i isolated analog amps RMS AC/DC input.

Two possible wiring diagrams are shown. The module's two points are isolated from each
Wiring for SNAP-AIVRMS analog volts RMS AC/DC input.

The two points on the SNAP-AIVRMS-i are isolated from each other.

Terminals 3, 4, 7, and 8 share a common connection inside the module. Make sure you observe polarity when connecting the second channel. To avoid a potentially hazardous short, double-check wiring before turning on the voltage to be monitored.
Wiring for SNAP-AICTD two-channel analog temperature input.

Wiring for SNAP-AICTD-4 four-channel analog temperature input.

Wiring for SNAP-AILC and SNAP-AILC-2 load cell inputs.
Wiring for SNAP-AIMA two-channel analog current input.

Since all inputs share a common reference, the module must be installed at the beginning or end of a typical 4–20 mA loop. If you are using both standard and self-sourcing transmitters, either put the transmitters on different modules, or use different power supplies. Do not use standard and self-sourcing transmitters on the same module.

This module does NOT supply

Wiring for SNAP-AIMA-4 four-channel analog current input.
Wiring for SNAP-AIMA-i and SNAP-AIMA2-i isolated two-channel analog current inputs.

Wiring for SNAP-AIPM analog power monitoring input.

For more information about this module, see Opto 22 form #1453, the SNAP-AIPM data sheet.
CAUTION: These terminals share a common connection inside the module. Make sure you observe polarity when connecting the second channel. To avoid a potentially hazardous short, double-check wiring before turning on the current to be monitored.

Measuring AC Line Current with a Current Transformer
Wiring for SNAP-AIMA-iSRC isolated two-channel analog current input.

The two channels are isolated from each other. This module DOES supply loop excitation current.

Wiring for SNAP-AIR40K-4 analog thermistor input.

NOTE: RESISTANCE PROBES MUST BE ELECTRICALLY ISOLATED FROM EACH OTHER.
Wiring for SNAP-AIRATE analog rate input.

Two possible wiring diagrams are shown:

Wiring for SNAP-AIMV-4 and AIMV2-4 analog millivolt inputs.

Wiring for SNAP-AITM and SNAP-AITM-2 analog thermocouple/millivolt inputs.

Since both inputs share the same reference terminal, use isolated probes for thermocouple inputs.
Wiring for SNAP-AITM-i and SNAP-AITM-2-i isolated analog thermocouple/milli-volt inputs.

Since these channels do not share any common connections, grounded sensors and field devices may be used with them.

Wiring for SNAP-AIRTD analog RTD input.

The SNAP-AIRTD is designed for three-wire connections, shown in the diagram at right.

Wiring for SNAP-AIV two-channel analog voltage input.

Note: The two reference terminals are connected internally.
Wiring for SNAP-AIV-4 four-channel analog voltage input.

Wiring for SNAP-AIV-i and SNAP-AIV2-i isolated two-channel analog voltage input.

The two channels are isolated from each other. Since these channels do not share any common connections, grounded sensors and field devices may be used with them.
Analog Output Modules

Wiring for the SNAP-AOA-3 single-channel analog current output.

![Wiring diagram for SNAP-AOA-3](image)

Wiring for the SNAP-AOV-5 single-channel analog voltage outputs.

![Wiring diagram for SNAP-AOV-5](image)
Wiring for the SNAP-AOA-23 dual-channel analog current output.

Both channels share a common reference terminal.

The module includes built-in loop sourcing capability. The two channels and their loop sources are isolated from each other.
Wiring for the SNAP-AOV-25 and SNAP-AOV-27 dual-channel analog voltage output.

Both channels share a common reference terminal.

Wiring for the SNAP-AOA-28 dual-channel analog current output.

Both channels share a common reference terminal.

Wiring for the SNAP-AOD-29 dual-channel analog time-proportional digital output.

Serial Communication Modules

Wiring for the SNAP-SCM-232 serial communication module.
Refer to Opto 22 form #1191, the *SNAP Serial Communication Module User’s Guide*, for more information.

**Wiring for the SNAP-SCM-485-422 serial communication module.**

### Pinouts for Two-Wire SNAP-SCM-485

<table>
<thead>
<tr>
<th>Pin</th>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>Vcc</td>
</tr>
<tr>
<td>2</td>
<td>A</td>
<td>TX/RX +</td>
</tr>
<tr>
<td>3</td>
<td>A</td>
<td>TX/RX -</td>
</tr>
<tr>
<td>4</td>
<td>A</td>
<td>Sig Gnd</td>
</tr>
<tr>
<td>5</td>
<td>B</td>
<td>Vcc</td>
</tr>
<tr>
<td>6</td>
<td>B</td>
<td>TX/RX +</td>
</tr>
<tr>
<td>7</td>
<td>B</td>
<td>TX/RX -</td>
</tr>
<tr>
<td>8</td>
<td>B</td>
<td>Sig Gnd</td>
</tr>
</tbody>
</table>

### Pinouts for Four-Wire SNAP-SCM-485

<table>
<thead>
<tr>
<th>Pin</th>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>Vcc</td>
</tr>
<tr>
<td>2</td>
<td>A</td>
<td>TX +</td>
</tr>
<tr>
<td>3</td>
<td>A</td>
<td>TX -</td>
</tr>
<tr>
<td>4</td>
<td>A</td>
<td>Sig Gnd</td>
</tr>
<tr>
<td>5</td>
<td>A</td>
<td>Vcc</td>
</tr>
<tr>
<td>6</td>
<td>A</td>
<td>RX +</td>
</tr>
<tr>
<td>7</td>
<td>A</td>
<td>RX -</td>
</tr>
<tr>
<td>8</td>
<td>A</td>
<td>Sig Gnd</td>
</tr>
</tbody>
</table>

**NOTE:** Vcc on the SNAP-SCM-485 is 5 VDC and is supplied by the module itself. Do not use this voltage to power another device, as it can interfere with normal module operation.
Use the small switches on the top of the module to provide bias or termination on the RS-485 network as required. If the port is physically the first or last device on the RS-485 network, provide termination by moving the Term switch to ON. Also provide bias at one point on the network by moving both the Up and Down switches to ON.

Bias and termination switches are shown in the diagram at right.

Refer to Opto 22 form #1191, the **SNAP Serial Communication Module User's Guide**, for more information.

![Diagram of SNAP-SCM-PROFI switches and connections](image)

**Wiring for the SNAP-SCM-PROFI serial communication module.**

Communication switches are shown in the diagram at right. If you are using an official PROFIBUS cable, termination is provided in the cable; therefore, switch the termination to ON in the cable and move the Term switch to OFF in the SNAP-SCM-PROFI module.

See the **SNAP Serial Communication Module User's Guide** (form #1191) for more information.

![Diagram of SNAP-SCM-W2 connections](image)

**Wiring for the SNAP-SCM-W2 serial communication module.**

**NOTE:** Use with SNAP PAC R-series, SNAP Ethernet, or SNAP Ultimate only.
SNAP PID Module

Connect PID output wiring as shown in the diagram below. If you want to use PID setpoint and process variable analog inputs from external sources with the SNAP PID module, also connect PID setpoint inputs to channel 0 and process variable inputs to channel 1, as shown.

PID output can be 4–20 mA current and 0–10 VDC voltage outputs, both of which share a common negative terminal. PID output is calculated by the module and then sent simultaneously to both current and voltage outputs as a percent of output scale. This PID output can be analog or TPO signals (if TPO is selected, both current and voltage outputs are switched from 0% to 100%).

NOTE: SNAP PID modules can be used with SNAP PAC R-series, SNAP Ethernet, or SNAP Ultimate only. However, we recommend using the PID loops built into these processors rather than using the separate module, especially if you are using ioControl.
Wiring for the SNAP-PID-V module.

NOTE: Analog inputs share a common reference and are not isolated from each other.
Index

Numerics
32-channel digital connector, 89
32-channel digital modules
   wiring, 89

A
accessing I/O unit over the Internet, 23
analog input modules
   power requirements, 75
   Q&A, 81
   resolution, 81
   troubleshooting, 69
   wiring, 92
analog output modules
   power requirements, 75
   Q&A, 81
   resolution, 81
   troubleshooting, 69
   wiring, 102
analog point features, 39
average filter weight, 40

B
backup battery, 43
battery, 43
blink codes, 63
brain
   feature comparison chart, 37
   installing, 10, 79
   power requirements, 75
   rack compatibility, 72


Scratch Pad, 29, 42
specifications, 35

C
cable
   crossover, 32
   straight-through, 32
changing
   IP address, 43
clamping, 40
communicating with brain, 21
   peer-to-peer, 29
   ping the brain, 60
   problems with, 59
   simultaneously, 22
   via modem, 16
communication
   choosing methods, 23
   serial, 40
   with enterprise systems, 30
computer, connecting directly to brain, 32
configuring
   modem communication, 12
   PPP, 12
connecting
   modem, 16
   to brain, troubleshooting, 59
   to the enterprise, 30
control side of Ultimate brain, 27
control strategy, 28
controller
   installing, 79
power requirements, 75
crack compatibility, 72
controller, sharing data with, 29
controlling multiple I/O units, 28
copying memory map data, 41
counter
  high-speed, 39
  quadrature, 39
crossover cable, 32
current loop power supply, wiring, 77

D
data
  copying, 41
  delivering to databases, 30
  logging, 41
  mirroring, 41
  sharing among Ultimate I/O units, 29
  streaming, 41
default settings for processor, 50
dial-up networking
  configuring, 12
  on Windows 2000, 17
digital input modules
  power requirements, 75
  Q&A, 80
  troubleshooting, 67
  wiring, 32-channel modules, 89
  wiring, standard, 84
digital output modules
  power requirements, 75
  Q&A, 80
  troubleshooting, 67
  wiring, 32-channel, 89
  wiring, standard, 85
digital point features, 39
direct connection, 32
downloading
  see loading

E
e-mail, 30, 41
treprise connectivity, 30
treprise management system, 30, 42
troblem codes
  blink codes, 63
Ethernet network
  accessing I/O unit over the Internet, 23
certification, 63
  connecting brain to, 33
troblems, 62
  independent control network, 34
trooubleshooting, 62
  event messages, 41
  events, 41

F
factory default settings, 50
features
  comparison chart for brains, 37
  descriptions, 39
filter weight, 40
finding out IP address, 47
firmware
  getting data about, 66
  loading to controller, 51
  loading to I/O unit, 51
  flowcharts, 28

G
gain, 40

H
hardware
  getting data about, 66
  help
  blink codes, 63
  LED descriptions, 35
  network problems, 62
  Product Support, 5
  troubleshooting, 59
  high-density digital modules
    power requirements, 75
    high-speed counters, 39
I
I/O modules
  32-channel digital, 89
  analog input, 92
  analog output, 102
  application information, 80
  basic diagram, 82
  installing, 8
  PID, 107
  power requirements, 75
  removing, 9
  serial, 104
  standard digital input, 84
  standard digital output, 85
  troubleshooting, 67
I/O point
  features, 37, 39
I/O side of Ultimate brain, 27
installing
  brain on rack, 10
  I/O modules, 8, 82
  I/O unit (quick start), 7
  modem, 16
  mounting rack, 8, 72
  power supplies, 74
  processor on rack, 79
Internet, accessing I/O unit over, 23
ioControl, 28
ioDisplay, 28
ioManager, 4
IP address
  changing, 43
  resetting to factory default, 50
  viewing, 43, 47
IP filtering, 41

J
jumpers, 64

K
kernel mode, 64
kernel, see firmware

L
latches, 39
LEDs
  blink codes, 63
  description, 35
  red, 59
Linux, 3
loader mode, 64
loading
  new firmware to I/O unit or controller, 51
logging data, 41
loop power supply, 77

M
maximum value, 40
memory map, 27, 29
  copying data, 41
  minimum value, 40
  mirroring data, 41
Modbus/TCP, 30
modem, 42
  connecting to brain, 16
  using PPP, 12
mounting rack
  installing, 8
  wiring, 72

N
network
  architecture, 32
  certification, 63
  Ethernet errors, 62
  independent, 34
  modem communication, 34
  OptoEnetSniff, 63
  troubleshooting, 62
  NVRAM, 17

O
offset, 40
OPC, 4, 30
Opto 22 Product Support, 5
OptoEnetSniff, 63
output clamping, 40

P
peer-to-peer communication, 29
PID loops, 40
PID modules
  power requirements, 75
  wiring, 107
ping, 60
point-to-point protocol, 42
port access, limiting, 41
power monitoring module, 96
power supply
  current loop, 77
  determining requirements, 74
  wiring, 74
PPP, 34, 42
  configuring, 12
problems, troubleshooting, 59
processor
  installing, 79
  power requirements, 75
  rack compatibility, 72
Product Support, 5
  getting device and firmware data, 66

Q
quadrature counters, 39
quick start, 7

R
rack for I/O modules
  compatibility, 72
  installing, 8
  wiring, 72
reading
  IP address, 47
  IP address and subnet mask, 43
removing I/O modules, 9
replacing backup battery, 43
resetting processor to factory defaults, 50
retransmit timeout (RTO), 64

S
scaling, 40
Scratch Pad areas, 29, 42
security, 41
serial communication, 40
serial connection to brain, diagram, 46, 48, 56
serial modules
  power requirements, 75
  wiring, 104
sharing data among Ultimate I/O units, 29
SMTP, 30
SNAP Ultimate brain
  diagram, 27
  memory map, 27, 29
  Scratch Pad area, 29
SNAP-AIARMS, 92
SNAP-AIARMS-i, 92
SNAP-AICTD, 94
SNAP-AICTD-4, 94
SNAP-AILC, 94
SNAP-AILC-2, 94
SNAP-AIMA, 95
SNAP-AIMA2-i, 96
SNAP-AIMA-4, 95
SNAP-AIMA-i, 96
SNAP-AIMA-iSRC, 98
SNAP-AIMV2-4, 99
SNAP-AIMV-4, 99
SNAP-AIPM, 96
SNAP-AIR40K-4, 98
SNAP-AIRATE, 99
SNAP-AIRTD, 100
SNAP-AITM, 99
SNAP-AITM-2, 99
SNAP-AITM-2-i, 100
SNAP-AITM-i, 100
SNAP-AIV, 100
SNAP-AIV2-i, 101
SNAP-AIV-4, 101
SNAP-AIV-i, 101
SNAP-AIVRMS, 93
SNAP-AIVRMS-i, 93
SNAP-AOA-23, 103
SNAP-AOA-23-iSRC, 103
SNAP-AOA-28, 104
SNAP-AOA-3, 102
SNAP-AOD-29, 104
SNAP-AOV-25, 104
SNAP-AOV-27, 104
SNAP-AOV-5, 102
SNAP-ENET-RTC brain, replacement battery, 43
SNAP-IDC-32, 90
SNAP-IDC5-SW, 84
SNAP-IDC5-SW-NC, 84
SNAP-OAC5, 85
SNAP-OAC5FM, 85
SNAP-OAC5-i, 85
SNAP-OAC5iFM, 85
SNAP-OAC5MA, 85
SNAP-ODC-32-SNK, 91
SNAP-ODC-32-SRC, 91
SNAP-ODC5-i, 88
SNAP-ODC5-iFM, 88
SNAP-ODC5ASNK, 86
SNAP-ODC5-i, 88
SNAP-ODC5-iFM, 88
SNAP-ODC5MA, 87
SNAP-ODC5R, 87
SNAP-ODC5R5, 87
SNAP-ODC5R5FM, 87
SNAP-ODC5RFM, 87
SNAP-ODC5SNK, 86
SNAP-ODC5SNKFM, 86
SNAP-ODC5SRC, 86
SNAP-ODC5SRCFM, 86
SNAP-PID-V, 108
SNAP-SCM-232, 104
SNAP-SCM-485, 105
SNAP-SCM-PROFI, 106
SNAP-SCM-W2, 106

SNMP, 30, 42
specifications, 35
straight-through cable, 32
strategy, 28
streaming data, 41
subnet mask, 43
system architecture, 32

T
TCP/IP
multiple sessions, 22
settings, 64
stack, 64
technical support, 5
third-party software, 30
timeout, 64
timers, 41
troubleshooting, 59
analog I/O modules, 69
blink codes, 63
digital I/O modules, 67
LED descriptions, 35
network, 62
Product Support, 5

U
UDP and streaming data, 41
Ultimate brain
diagram, 27
memory map, 27, 29
Scratch Pad area, 29
utilities
OptoEnetSniff, 63

W
watchdog, 39